Provides an overview of this Windows-based backup and recovery solution

Discusses extensively how to implement and use the solution

Includes service solution scenarios as well as best practices
Note: Before using this information and the product it supports, read the information in “Notices” on page vii.
Contents

Notices ................................................................. vii
Trademarks ......................................................... viii

Preface ................................................................. ix
The team that wrote this book .................................................. ix
Become a published author .................................................... xi
Comments welcome .......................................................... xi

Part 1. Planning .......................................................... 1

Chapter 1. Solution introduction ........................................... 3
1.1 Tivoli Storage Manager FastBack overview .............................. 4
1.2 Product positioning ..................................................... 5
1.3 Product architecture ................................................... 6
1.3.1 Tivoli Storage Manager FastBack Server ......................... 7
1.3.2 Tivoli Storage Manager FastBack Client ......................... 8
1.3.3 Tivoli Storage Manager FastBack Manager ..................... 9
1.3.4 Tivoli Storage Manager FastBack Mount and Instant Restore .... 10
1.3.5 Tivoli Storage Manager FastBack Administrative Command Line Client ........................................... 11
1.3.6 Tivoli Storage Manager FastBack Hub Server and Central Control Station .............................................. 11
1.3.7 Tivoli Storage Manager FastBack for Microsoft Exchange .... 15
1.3.8 Tivoli Storage Manager FastBack for Bare Machine Recovery .. 17
1.4 Tivoli Storage Manager FastBack value proposition ................ 17
1.4.1 Tiered recovery snapshot ......................................... 18
1.4.2 Key features ....................................................... 19

Chapter 2. Solution environment .......................................... 23
2.1 Requirements of Tivoli Storage Manager FastBack .................. 24
2.1.1 Tivoli Storage Manager FastBack Server requirements .......... 24
2.1.2 Tivoli Storage Manager FastBack Client requirements .......... 25
2.1.3 Tivoli Storage Manager FastBack for Microsoft Exchange software requirements ............................................. 27
2.1.4 Tivoli Storage Manager FastBack for Bare Machine Recovery requirements .............................................. 27
2.1.5 Tivoli Storage Manager FastBack Server repository considerations .............................................. 27
2.2 Tivoli Storage Manager FastBack sizing and operational considerations . 30
## Contents

5.1.1 Usage scenarios ........................................ 110
5.1.2 Environment setting .................................... 111
5.2 Working with a repository ................................. 112
  5.2.1 Configuring the initial repository .................... 112
  5.2.2 Defining a repository ................................. 114
5.3 Basic configuration for client backup .................... 116
  5.3.1 Defining a client group ............................... 117
  5.3.2 Defining a schedule ............................... 119
  5.3.3 Defining a policy .................................... 121
  5.3.4 Testing the policy .................................... 125
5.4 Data recovery ............................................ 126
  5.4.1 Volume recovery .................................... 127
  5.4.2 File recovery ...................................... 129
  5.4.3 Hub server recovery .................................. 134
5.5 Continuous Data Protection ............................... 136
  5.5.1 Configuring Continuous Data Protection .............. 137
  5.5.2 Restoring Continuous Data Protection snapshot ......... 138
5.6 Microsoft Exchange server protection .................... 141
  5.6.1 Configuring a Microsoft Exchange 2003 client ............ 143
  5.6.2 Direct restoration for Microsoft Exchange ............. 144
  5.6.3 Restoring e-mail using SMTP .......................... 151
  5.6.4 Saving a Microsoft Exchange e-mail ...................... 153
5.7 Backing up and restoring a Microsoft SQL Server database .... 153
  5.7.1 Configuring the backup for Microsoft SQL Server ......... 153
  5.7.2 Restoring a Microsoft SQL Server database ............. 159
5.8 Performing a Bare Machine Recovery ..................... 161
  5.8.1 Example of a common Bare Machine Recovery scenario .. 162

Chapter 6. Best practices and troubleshooting tips .................. 171
6.1 Troubleshooting information ............................... 172
  6.1.1 FastBack Manager event log ........................... 173
  6.1.2 FastBack Server logs .................................. 174
  6.1.3 FastBack Client and FastBack Mount logs ............... 174
  6.1.4 FastBack Hub Server logs ............................. 176
6.2 Miscellaneous hints and tips ............................... 176
  6.2.1 Installation and configuration considerations ............ 177
  6.2.2 Operational considerations ............................ 179
  6.2.3 Integration considerations ............................. 185
6.3 Tivoli Storage Manager integration ....................... 192
  6.3.1 Configuration overview ............................... 194
  6.3.2 Installation steps .................................... 196
  6.3.3 Operational aspects with Tivoli Storage Manager client .... 202
Part 3. Appendixes

Appendix A. Volume Shadow Copy Service .......................... 205
  Volume Shadow Copy Service (VSS) overview .................... 206
  Configuring Volume Shadow Copy Services ....................... 207

Appendix B. REXX utility for simulating file server operation ...... 209
  REXX utility operation ........................................ 210
  REXX utility source code ....................................... 211

Appendix C. Additional material .................................... 215
  Locating the Web material ..................................... 216
  Using the Web material .......................................... 216
    System requirements for downloading the Web material ......... 216
    How to use the Web material ................................. 216

Abbreviations and acronyms .......................................... 217

Related publications ................................................ 219
  IBM Redbooks publications .................................... 219
  Other publications ............................................. 219
  Online resources ............................................... 220
  How to get IBM Redbooks publications ......................... 221
  Help from IBM .................................................. 221

Index ................................................................. 223
Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing, IBM Corporation, North Castle Drive, Armonk, NY 10504-1785 U.S.A.

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs.
Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business Machines Corporation in the United States, other countries, or both. These and other IBM trademarked terms are marked on their first occurrence in this information with the appropriate symbol (® or ™), indicating US registered or common law trademarks owned by IBM at the time this information was published. Such trademarks may also be registered or common law trademarks in other countries. A current list of IBM trademarks is available on the Web at http://www.ibm.com/legal/copytrade.shtml

The following terms are trademarks of the International Business Machines Corporation in the United States, other countries, or both:

AIX®
Database 2™
DB2®
Domino®

DS8000™
IBM®
Lotus®
Redbooks®

Redbooks (logo) ®
REXX™
SysBack™
Tivoli®

The following terms are trademarks of other companies:

Acrobat, Adobe, and Portable Document Format (PDF) are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States, other countries, or both.

ATI, the AMD Arrow logo, and combinations thereof, are trademarks of Advanced Micro Devices, Inc.

ITIL is a registered trademark, and a registered community trademark of the Office of Government Commerce, and is registered in the U.S. Patent and Trademark Office.

Snapshot, and the NetApp logo are trademarks or registered trademarks of NetApp, Inc. in the U.S. and other countries.

Oracle, JD Edwards, PeopleSoft, Siebel, and TopLink are registered trademarks of Oracle Corporation and/or its affiliates.

VMware, the VMware "boxes" logo and design are registered trademarks or trademarks of VMware, Inc. in the United States and/or other jurisdictions.

Java, Sun, and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

Active Directory, Microsoft, MS, Outlook, SQL Server, Windows Server, Windows, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.

Intel Pentium, Intel, Itanium, Pentium, Intel logo, Intel Inside logo, and Intel Centrino logo are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the United States, other countries, or both.

Linux is a trademark of Linus Torvalds in the United States, other countries, or both.

Other company, product, or service names may be trademarks or service marks of others.
Preface

This IBM® Redbooks® publication is written as part of the deployment guide series. It discusses the IBM Tivoli® Storage Manager FastBack product family. Tivoli Storage Manager FastBack is a complete backup, recovery, and continuous data protection solution for Windows® based servers. It is a new addition to the IBM Tivoli Storage Manager family of products.

Tivoli Storage Manager FastBack includes a specialized solution for backing up Microsoft® Exchange server and provides Bare Machine Recovery. Tivoli Storage Manager FastBack also supports a disaster recovery scenario by providing a hub server that centralizes recovery from multiple locations.

The book is written in a deployment guide format. Thus, it contains an extensive guide for implementation services and requirement considerations. It explains how to install Tivoli Storage Manager FastBack, as well as how to use the solution. It also includes demonstration scenarios.

The team that wrote this book

This book was produced by a team of specialists from around the world working at the International Technical Support Organization, Austin Center.

Budi Darmawan is a project leader at the International Technical Support Organization, Austin Center. He writes extensively and teaches IBM classes worldwide on all areas of Tivoli and systems management. Before joining the ITSO 10 years ago, Budi worked in IBM Indonesia as a lead implementer and solution architect. His current interests are systems and application management, Java™ programming, and service management.

Guillermo Garcia is a Technical Consultant in the IBM Business Partner Innovation Center (BPIC) in Ecuador with NEXSYS (The IBM Software Value Added Distributor in Ecuador). He has 7 years of experience in the IT field. He has worked at NEXSYS for 2 years, supporting pre-sales and training IBM Business Partners. He has IBM technical certifications in Tivoli Storage Manager, Tivoli Provisioning Manager, and Tivoli Monitoring and a Solution Advisor in Tivoli Security. Guillermo also teaches at ATI™ in Escuela Politecnica Nacional and has Microsoft, Symantec, and ITIL® Foundation Certification in IT Service Management.
Klemens Poschke is a certified IBM Senior IT Architect in Germany. He joined IBM 31 years ago. Since 1993, he has worked in Tivoli Storage Manager consulting, with the past 8 years as a Technical Pre-sales for Software group consultant in Duesseldorf, Germany. He holds a master degree in Communication Technologies from University of Koblenz. During different working roles in IBM (hardware support, service planning for mainframe, and sales support functions), he gained experience in many different areas of the hardware and software portfolios available from IBM.

Andy Seddon is a Senior IT Specialist in the U.K. who joined IBM in 1998 from an international bank. He holds a degree in Computer-Aided Engineering from Staffordshire University and has worked in Europe and the U.S. on large IT infrastructure projects in all industry sectors. Andy has worked in the IBM Software Group for the past 5 years, specializing in storage software. His areas of expertise include Tivoli Storage Manager, Storage Area Networks, and Microsoft Windows infrastructures. He advises clients in the financial services sector on storage and backup/recovery strategy.

Figure 1  Project team: Budi Darmawan, Andy Seddon, Klemens Poschke, Guillermo Garcia

Thanks to the following people for their contributions to this project:

IT Support Specialist, Jon Etkins
International Technical Support Organization, Austin Center

Jim P. Smith, David G. van Hise, Greg Tevis
IBM Tivoli Storage Manager development

Oren Wolf, Omer Alterescu
IBM Tivoli FastBack worldwide support and enablement
Become a published author

Join us for a two- to six-week residency program! Help write a book dealing with specific products or solutions, while getting hands-on experience with leading-edge technologies. You will have the opportunity to team with IBM technical professionals, Business Partners, and Clients.

Your efforts will help increase product acceptance and client satisfaction. As a bonus, you will develop a network of contacts in IBM development labs, and increase your productivity and marketability.

Find out more about the residency program, browse the residency index, and apply online at:

ibm.com/redbooks/residencies.html

Comments welcome

Your comments are important to us!

We want our books to be as helpful as possible. Send us your comments about this book or other IBM Redbooks in one of the following ways:

- Use the online Contact us review Redbooks form found at:
  ibm.com/redbooks
- Send your comments in an e-mail to:
  redbooks@us.ibm.com
- Mail your comments to:
  IBM Corporation, International Technical Support Organization
  Dept. HYTD Mail Station P099
  2455 South Road
  Poughkeepsie, NY 12601-5400
Part 1

Planning

In this part, we discuss planning information for IBM Tivoli Storage Manager FastBack implementation. This part includes the following chapters:

- Chapter 1, “Solution introduction” on page 3
- Chapter 2, “Solution environment” on page 23
- Chapter 3, “Project planning” on page 39
IBM Tivoli Storage Manager FastBack V5.5 is a new product in the Tivoli Storage Manager portfolio and is intended for Windows-based office data protection and recovery. It offers selectable levels of protection, from continuous to frequent to scheduled, on a per-application basis. You can recover any data element from a single file, e-mail message, or an entire server and can perform recovery either from a central location or directly in the remote branch office.

In this chapter, we discuss the following topics:

1.1, “Tivoli Storage Manager FastBack overview” on page 4
1.2, “Product positioning” on page 5
1.3, “Product architecture” on page 6
1.4, “Tivoli Storage Manager FastBack value proposition” on page 17
1.1 Tivoli Storage Manager FastBack overview

Tivoli Storage Manager FastBack is a new member of the Tivoli Storage Manager product family. It addresses enterprise customers with branch office structures and smaller customers who need to provide fast backup/recovery disk-based services combined with minor administration involvement and highly automated capabilities that exploit fast and modern disk-snapshot backup/recovery functions.

Tivoli Storage Manager FastBack is a solution for protecting Microsoft Windows files and applications and the Windows operating system with specific support of common Windows applications (Microsoft Exchange and Microsoft SQL). It addresses complete backup/restore requirements, ranging from daily backups to frequent backups to continuous backups, as well as bare machine recovery for file and application servers. Tivoli Storage Manager FastBack also provides functions for remote disaster protection by supporting several local Tivoli Storage Manager FastBack installations with one remote Tivoli Storage Manager FastBack Disaster Recovery Hub Server. The remote hub server can be operated as a client to Tivoli Storage Manager server for moving backup data to magnetic tape.

The Tivoli Storage Manager FastBack product suite contains different functional components that are combined into the following major product packages (as shown in Table 1-1 on page 5):

- Tivoli Storage Manager FastBack includes all the components that are necessary to back up and restore file data from servers and those applications with no integrated Tivoli Storage Manager FastBack support, including:
  - Tivoli Storage Manager FastBack Restore Server
  - Tivoli Storage Manager FastBack Client
  - Tivoli Storage Manager FastBack Manager
  - Tivoli Storage Manager FastBack Mount and Instant Restore
  - Tivoli Storage Manager FastBack Administrative Command Line Client
  - Tivoli Storage Manager FastBack Hub Server
  - Tivoli Storage Manager FastBack Central Control Station

- Tivoli Storage Manager FastBack for Microsoft Exchange includes the Tivoli Storage Manager FastBack Client, which is needed for Microsoft Exchange to perform mailbox and mail item recovery.

- Tivoli Storage Manager for Bare Machine Recovery includes the code for restoring file servers or application servers from scratch using a customized boot CD and for restoring the backup snapshots that were stored previously.

- Tivoli Storage Manager FastBack Center includes all package components.
Table 1-1  *Tivoli Storage Manager FastBack license package overview*

<table>
<thead>
<tr>
<th>Product</th>
<th>Program Number</th>
<th>New Licence Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tivoli Storage Manager FastBack</td>
<td>5274-U93</td>
<td>D04R6LL</td>
</tr>
<tr>
<td>Tivoli Storage Manager FastBack for Microsoft Exchange</td>
<td>5274-U94</td>
<td>D04R8LL</td>
</tr>
<tr>
<td>Tivoli Storage Manager FastBack for Bare Machine Recovery</td>
<td>5274-U95</td>
<td>D04RALL</td>
</tr>
<tr>
<td>Tivoli Storage Manager FastBack Center</td>
<td>5274-U35</td>
<td>D04RDLL</td>
</tr>
</tbody>
</table>

1.2 Product positioning

Over time, there might be deeper integration of Tivoli Storage Manager FastBack throughout the current Tivoli Storage Manager portfolio. Currently, the available integration uses Tivoli Storage Manager ability from the Tivoli Storage Manager FastBack Disaster Recovery Hub Server to send backed up data to magnetic tape devices using Tivoli Storage Manager client. We discuss this integration in 6.3, “Tivoli Storage Manager integration” on page 192.

The following functions overlap between Tivoli Storage Manager FastBack and other IBM Tivoli solutions:

- Continuous Data Protection
  IBM Tivoli Continuous Data Protection for Files product remains still the offering from IBM for continuous data protection for user workstations and notebooks with optional data movement into Tivoli Storage Manager server.

- Bare Machine Recovery
  Cristie Bare Machine Recovery (BMR) remains the solution for enterprise-wide BMR strategies and supports Windows, Linux®, Sun™, and HP-UX backup to Tivoli Storage Manager Standard or Enterprise Edition.

- Tivoli Storage Manager for SysBack™
  This solution is the preferred BMR solution for AIX®.
1.3 Product architecture

This section discusses the structure and components of Tivoli Storage Manager FastBack.

Figure 1-1 shows the relationship between different product components.

![Diagram showing Tivoli Storage Manager FastBack architecture]

Each component has a different role for management, backup, recovery, and data replication, as follows:

- **Management**
  
  You can manage Tivoli Storage Manager FastBack from the local server using the FastBack Manager or FastBack Administrative Command Line Client. You can have a central management from the FastBack hub server using the Central Control Station.

- **Backup**
  
  The Tivoli Storage Manager FastBack Server communicates with the FastBack Client.
Chapter 1. Solution introduction

- **Recovery**
  Different recovery scenarios uses different components:
  - A standard restoration uses the Tivoli Storage Manager FastBack Server and FastBack Client.
  - The client can use FastBack Mount and Instant Restore to recover part of the file system.
  - BMR allows a full boot partition recovery.

- **Replicating**
  To replicate the data between a branch office and a data center, you can use Tivoli Storage Manager FastBack Hub Server managed from the Central Control Station.

### 1.3.1 Tivoli Storage Manager FastBack Server

The Tivoli Storage Manager FastBack Server is a critical component in the FastBack architecture and is installed on a dedicated machine. FastBack Server is running in the background as a Microsoft Windows service. It manages all the backup procedures as well as some of the recovery options.

The Tivoli Storage Manager FastBack Server uses TCP/IP communication to communicate with Tivoli Storage Manager FastBack Manager and Tivoli Storage Manager FastBack Client. Tivoli Storage Manager FastBack Server manages the repository where the backup server keeps all the data that is being backed up.

The following disk technologies can be used as repository components:

- **Full disks (block devices), either direct attached storage (SATA, IDE or SCSI) or SAN storage (FC or iSCSI)**
- **Volumes and folders**
- **Network Attached Storage devices**

Tivoli Storage Manager FastBack Server is the component that schedules snapshots.

**Recovery operation**

Tivoli Storage Manager FastBack Server is the initiator of traditional volume restoration. You can initiate data to stream from FastBack Server to FastBack Client, which writes the data to the selected volume, thus rolling back the selected volume to a different point in time. The volume is not usable throughout
the restoration operation. Tivoli Storage Manager FastBack Server can perform a volume restoration to a SAN volume, providing that no one else is accessing this volume.

FastBack Server also provides an IT-free file level restoration. This recovery option is currently available for NTFS volumes only. When this option is enabled, the Tivoli Storage Manager FastBack Server exposes a network share on the local network, allowing users to access all the backed up data. This option is integrated with Active Directory® to ensure authentication so a user has the same access level to the backup share as though the access is from the production servers.

1.3.2 Tivoli Storage Manager FastBack Client

Tivoli Storage Manager FastBack Client runs as a Microsoft Windows service installed on the production servers to be protected.

Note: Tivoli Storage Manager FastBack is intended to backup or restore server environments. The licenses do not allow you to perform cloning or BMR on user workstations or notebooks.

Tivoli Storage Manager FastBack Client communicates with the Tivoli Storage Manager FastBack Server using standard TCP/IP communication to give incremental block level snapshots for backups and restores. FastBack Client has the following functions:

- Identifies disk layout and installed application and their configurations.
- Keeps track of I/O to enable incremental snapshots and Continuous Data Protection (CDP).
- Transfers data to the Tivoli Storage Manager FastBack Server if needed.
- Ensures a point-in-time (PIT) copy of the production volume using copy-on-write (COW) technology.
- Quiesces the applications (that is, tells the applications to flush their memory cache to the disk) before the backup starts.
Backup scenarios
We used Tivoli Storage Manager FastBack Client in the backup scenarios in this book. The Tivoli Storage Manager FastBack Server is the instance that schedules the snapshots, but after a snapshot is initiated, FastBack Client performs the following actions:

- Transfers the incremental bitmap it gathered to the backup server.
- Performs the appropriate application quiescing.
- Transfers the snapshot data to the backup server.
- Uses copy-on-write to ensure a consistent point-in-time copy of the volume.

Recovery scenarios
Alternatively, you can use Tivoli Storage Manager FastBack Client to perform traditional volume recovery (as described in “Recovery operation” on page 7).

1.3.3 Tivoli Storage Manager FastBack Manager

Tivoli Storage Manager FastBack Manager is the Java console that administrators use to configure backups, initiate restoration operations, and view the system state either from the local branch office or from a disaster recovery site in a central location. Tivoli Storage Manager FastBack Manager is installed automatically on the Tivoli Storage Manager FastBack Server machine. Optionally, you can install it also in the central disaster recovery location on the Tivoli Storage Manager FastBack Hub Server to use the integrated hook up function in Central Control Station.

The FastBack Manager uses standard TCP/IP communication to talk to the backup server. This communication can be performed over LAN or WAN connection using a proprietary protocol. The FastBack Manager can ask the server for information, which it then parses and displays in a GUI. It also uses the GUI to receive commands from the user (for example, to define a client group, schedule a job, abort running snapshot, initiate a snapshot, tweak various configuration options, and so on) and sends those commands to the FastBack Server.

You can issue two types of commands from the GUI:

- Update configuration: FastBack Server saves the updated configuration in the appropriate configuration file. A typical scenario is a backup definition.

- Perform an action: FastBack Server performs the action that is needed. A typical scenario is to initiate a snapshot
1.3.4 Tivoli Storage Manager FastBack Mount and Instant Restore

Tivoli Storage Manager FastBack Mount and Instant Restore share the same GUI, which is driven by an underlying Microsoft Windows service that allows the user to access the data in the Tivoli Storage Manager FastBack server's repository. The repository can be accessed directly (when the application or client has direct access to the repository). A typical scenario is when FastBack Mount is installed on the Tivoli Storage Manager FastBack server. The other option is when the repository is on the SAN or through the network. After the connection to the repository is established, the user can select the snapshot to access and can perform various restoration operations.

**Note:** The data stored in the repository cannot be altered by the user. FastBack Mount can give the user read/write access to snapshot data, but the write operations are discarded.

**Backup scenarios**
FastBack Mount can expose the backed up snapshot to any server that is used in recovery scenarios as well as a other operations, which include the following common scenarios:

- **Backup verification:** The user can mount a snapshot and run a verification utility (such as chkdsk, scandisk, eseutil, or DBCC) to verify the integrity of the snapshot.

- **Tape integration and archiving:** After a volume is mounted, any tape backup software (such as Tivoli Storage Manager, CA BrightStor, or Symantec Backup Exec) can access the files and back up the files to tape.

**Recovery scenarios**
Recovery scenarios include:

- **Mounting a snapshot**
  A selected snapshot can be mounted in either read only or read/write mode. After the snapshot is mounted, it is accessible to the user through My Computer. The user can go to the new virtual volume and restore a single file or folder (by copying the file or folder from that virtual volume).

- **Instant recovery**
  Instant recovery provides an instant volume restoration. This restoration allows users to start reading and writing data as soon as the restoration operation begins, while the restoration operation executes in the background. Tivoli Storage Manager FastBack Mount uses a standard file system interface to interact with the repository.
When performing instant recovery, the drivers monitor all reads and the application, allowing prioritization of the restoration of specific data blocks according to the operating system requests. This procedure makes sure that performance degradation throughout the restoration process is minimal.

1.3.5 Tivoli Storage Manager FastBack Administrative Command Line Client

Tivoli Storage Manager FastBack Administrative Command Line Client is a comprehensive tool that works with both Tivoli Storage Manager FastBack Server and Tivoli Storage Manager FastBack Mount. It uses TCP/IP communication to talk to those applications that using the Tivoli Storage Manager FastBack protocol.

The Administrative Command Line Client has two modes of operations:

- Interactive mode
  Provides most of the Tivoli Storage Manager FastBack Manager functionalities. It allows you to add or change configurations and to monitor the system's state. All actions are done in text mode.

- Quiet mode
  Sends commands to Tivoli Storage Manager FastBack Mount or Tivoli Storage Manager FastBack Server that are carried out by the target component. A response is then returned to the calling process. A common scenario where this mode is used is the tape integration by Tivoli Storage Manager. Tivoli Storage Manager uses the Administrative Command Line Client to mount a snapshot prior to running a tape backup and dismounts the snapshot when the backup is complete.

1.3.6 Tivoli Storage Manager FastBack Hub Server and Central Control Station

The disaster recovery function within Tivoli Storage Manager FastBack Server replicates the backup repository to an off site location (disaster recovery site) with Tivoli Storage Manager FastBack Hub Server installed. Thus, all Tivoli Storage Manager FastBack restoration capabilities are enabled in case of an outage.

Tivoli Storage Manager FastBack Server together with Tivoli Storage Manager FastBack Hub Server allows selective and scheduled replication of the backup repository to a disaster recovery site. Not all backups must be replicated, and
bandwidth can be better used by scheduling disaster recovery to low activity hours.

The Tivoli Storage Manager FastBack Hub Server solution uses a proprietary protocol built over the standard FTP protocol. This approach benefits from the advantages of the well known FTP protocol (such as firewall friendly, performance, and stability), while adding value from FastBack (compression, performance optimization, and special error handling). Tivoli Storage Manager FastBack Disaster Recovery protocol also uses the standard FTP over SSL features to allow secure transfer.

On the disaster recovery site, Tivoli Storage Manager FastBack Hub Server works on top of an existing standard FTP server, providing all the functionality needed at the disaster recovery site.

Central Control Station (CCS) is a graphical user interface for Tivoli Storage Manager FastBack Hub Server to monitor and manage all incoming replication data from remote Tivoli Storage Manager FastBack servers. It can be combined with Tivoli Storage Manager FastBack Manager in the disaster recovery location to administer all remote Tivoli Storage Manager FastBack restoration servers directly out of the Central Control Station graphical interface. In addition, Tivoli Storage Manager FastBack Mount, Bare Machine Recovery, and Instant Restore also can be installed at the central disaster recovery site. Thus, even without a Tivoli Storage Manager FastBack server, all restoration capabilities exist. The Tivoli Storage Manager FastBack Hub Server, together with Tivoli Storage Manager FastBack Mount and scripts provided, currently work as the interface for backing up replicated data on tape (such as by using Tivoli Storage Manager).

Tivoli Storage Manager FastBack Hub Server includes the following key features and functions:

- **Selective replication**
  
  The user can decide which backup policies are replicated and, thus, get better protection even if there is not enough bandwidth to replicate the entire backup repository. An example might be a volume that is backed up by two policies (one every hour and the other daily). Only the daily backup can be replicated if the bandwidth does not suffice for replicating the more frequent policy.

- **Scheduled replication**
  
  The replication can be scheduled to any time and any frequency to meet the security and bandwidth demands.
FastBack disaster recovery standard protocol

Communication between the Tivoli Storage Manager FastBack Disaster Recovery server and Hub Server is based on the standard FTP protocol.

Encryption

Tivoli Storage Manager FastBack Disaster Recovery protocol supports the standard SSL and TLS security protocols, which allow up to 128-bit encryption. It also supports both server and client side certificates.

Compression

Tivoli Storage Manager FastBack Disaster Recovery protocol supports compression over the wire, which allows better performance and bandwidth utilization.

Management

Managing the disaster recovery process is done either at the local site by FastBack Manager or at the disaster recovery site by Central Control Station together with FastBack Manager.

Recovery scenarios

Tivoli Storage Manager FastBack Mount provides all Tivoli Storage Manager FastBack recovery abilities for the disaster recovery site. It provides file level restoration, Bare Machine Recovery, and Instant Restore. It also supports integrating with a tape backup solution at the disaster recovery site, the same as at the local site.
Failover

The rapid recovery abilities of Tivoli Storage Manager FastBack allow restoring the servers at the disaster recovery site quickly to provide failing over in case of an outage. A simple process can allow FastBack Server to continue protecting the failed-over servers at the disaster recovery site, as illustrated in Figure 1-2.

![Diagram](image)

**Figure 1-2  Tivoli Storage Manager FastBack Disaster Recovery scenario**

Tivoli Storage Manager FastBack Server is deployed in the remote branch and used to replicate the data from the branch’s repository to the disaster recovery site over the WAN or LAN connection. At the disaster recovery site, Tivoli Storage Manager FastBack Hub Server receives the compressed and encrypted data from one or more branches. This transfer activity can be viewed by the Central Control Station, which gives the person acting as disaster recovery site manager a view over all the data, replication processes, and remote branches status.

The disaster recovery site manager can then use Tivoli Storage Manager FastBack’s recovery tools (FastBack Mount, Instant Restore, Bare Machine Recovery, and Exchange Restore) in order to perform various recoveries in the disaster recovery site.
1.3.7 Tivoli Storage Manager FastBack for Microsoft Exchange

Tivoli Storage Manager FastBack for Microsoft Exchange includes an intuitive Windows-style GUI that lets administrators view the contents of any Microsoft Exchange 2000, 2003, or 2007 database. Tivoli Storage Manager FastBack for Microsoft Exchange can even open and recover corrupt Exchange databases.

When coupled with Tivoli Storage Manager FastBack Server, Tivoli Storage Manager FastBack for Microsoft Exchange can recover e-mail objects from any previous point-in-time, enabling fast recovery from virus attacks and rolling corruptions.

Exchange objects can be restored directly to an Exchange server from the FastBack Exchange client or can be sent using SMTP to a user-defined destination. For secure operation and access, Tivoli Storage Manager FastBack for Microsoft Exchange is integrated with Active Directory and Exchange Server security to limit access to only authorized users at both the backup and restoration systems. Tivoli Storage Manager FastBack for Microsoft Exchange uses the messaging API from Exchange to communicate with the Exchange server or to read directly from the *.PST files.

Tivoli Storage Manager FastBack for Microsoft Exchange also has a simple search utility that allows users to search throughout multiple mailboxes for specific items.
Figure 1-3 shows an architectural overview on mailbox and item level recovery for Microsoft Exchange.

Figure 1-3   FastBack for Microsoft Exchange mailbox/single item recovery

**Recovery scenarios**
Here are some common scenarios where FastBack for Microsoft Exchange can become helpful:

- Recover deleted e-mail messages.
- Recover a user address book after the address book is accidentally synchronized from the new system to the Exchange database in the wrong direction.
- Help with exchange migrations.
1.3.8 Tivoli Storage Manager FastBack for Bare Machine Recovery

Tivoli Storage Manager FastBack Server supports Bare Machine Recovery (BMR) on both 32-bit and 64-bit Windows operating systems and processors. BMR is useful in situations where disk or system-level recovery is required, including:

- Recovering from a corrupted operating system
- Recovering from failed system hardware
- Restoring a disk to the same or a different disk on the same computer due to disk failure
- Creating clone disks (including the operating system) for deployment
- Restoring the operating system and environment due to wrong installations or patches (such as, restore to the same disk and same boot volume)

The BMR process is driven by a boot CD. (The FastBack Recovery CD is delivered within the license package.) This CD is based on Windows PE (preinstallation environment) and allows you to boot the machine and configure the network properties. You point to the Tivoli Storage Manager FastBack Server (using the host name), and the BMR console launches. Then, you select the operating system volume to recover and the disk for the restoration target. The restoration process begins, and after the restoration is complete, you can reboot the machine and initiate instant restore for the data volumes.

1.4 Tivoli Storage Manager FastBack value proposition

Mission critical applications are vital to all enterprises. Any disruptions to these applications, whether from downtime or data loss, can result in significant pain and potentially a huge financial impact. The Tivoli Storage Manager FastBack restoration process supports online backup using its application aware backup integration for applications such as Microsoft Exchange or Microsoft SQL and provides a mechanism to move the application into a consistent state using preprocessing exits. This eliminates the need to shut down these applications for nightly backups and provides immediate recovery of data following any type of loss.
1.4.1 Tiered recovery snapshot

Tivoli Storage Manager FastBack can perform snapshots. The snapshot can be provided in three levels or tiers of recovery services, as shown in Figure 1-4.

![Figure 1-4  Tivoli Storage Manager FastBack tiered recovery services](image)

Tivoli Storage Manager FastBack includes the following levels of tiered recovery services:

- **Scheduled**
  
  Periodic incremental or full snapshots allows recovery to daily, weekly, or monthly versions. This service is a good fit for non-mission-critical data and applications.

- **Frequent**
  
  Frequent incremental snapshots allow recovery to selected points in time. This service is a best fit for most data and applications and is the recommended option for Tivoli Storage Manager FastBack.

- **Continuous**
  
  Optionally, by intercepting every I/O request, Tivoli Storage Manager FastBack allows recovery to any point in time since the last snapshot. This service is a best fit for critical data and applications with currency requirements; however, this service requires significant bandwidth.
Tivoli Storage Manager FastBack includes the following functions:

- Eliminates the need for traditional backup windows by continuously capturing the changes in data at the block level using flexible policies
- Unique instant restoration capability (start working even if the restoration has not completed)
- Replace the use of tape in small or remote offices with an option to generate tape copies in a disaster recovery site
- Integrates with your existing tape backup applications (Tivoli Storage Manager-Server)
- Individual Mail Item restoration without any configuration
- SAN enabled
- Built in block level CDP
- Application aware CDP
- Bare Machine Recovery built in
- Active Directory support

1.4.2 Key features

The following are the key features of Tivoli Storage Manager FastBack:

- Block-level snapshot

  File-level data protection solutions typically need to scan the entire file system to determine changes since the last backup. This scan can be extremely time consuming and can cause a major drain on processor power, especially in systems with millions of files. This effect is eliminated in products such as Tivoli Storage Manager that use techniques such as journaling.

  File-level solutions also copy entire files that are changed, even if only one record in a multi-gigabyte database was added or changed. The block-level snapshot technology captures only changed data blocks as they are written to disk.

  Thus, there is no need to scan the file system or copy entire large files. An entire backup cycle takes just a few minutes rather than hours or even days. Of course, the benefit of a file-level approach is the ability to recover individual files and folders rather than the entire volume, but FastBack covers that as well, as described later in this list under granular recovery and instant restore.
► Incremental-forever
After performing an initial full backup, FastBack Client captures only changed data and builds a synthetic full copy of the protected data. This method saves storage space, reduces the load on application servers, and eliminates the need to run full backups on weekends.

► Policy engine
There is no “one size fits all” solution to complex data protection and recovery requirements. The policy engine with Tivoli Storage Manager FastBack can adjust the frequency of backup, up to and including true CDP, to the needs of each individual application. For example, you can set policies to protect a mission-critical database application every 10 minutes, your e-mail server every hour, and the file server once per day.

► Granular recovery
Tivoli Storage Manager FastBack includes a feature called Tivoli Storage Manager FastBack Mount that provides an Explorer-like file system view of the data in the backup repository. You can open or restore any file or folder, from any point in time, with just a point-and-click or drag-and-drop. Users can be given the ability to recover their own files, as well. Tivoli Storage Manager FastBack also offers Exchange Restore, which can be used in combination with the FastBack restoration process or as a stand-alone tool to recover individual e-mail messages, contacts, calendar items, notes, and tasks, even from corrupted Exchange Databases (EDBs).

► Instant restore
When an entire volume or system needs to be restored, Tivoli Storage Manager FastBack provides technology for making the full data set available immediately, usable by both applications and users, while the data is restored in the background. Any requested interactions with the data are serviced through the repository until the data is restored in full. Downtime is all but eliminated.

► Selective replication
Moving a copy of data over a WAN link, so that it can be restored in the case of a local or regional disaster, can cost a large amount of bandwidth using common synchronous and asynchronous replication solutions. Even if a file is changed hundreds of times a day, every change written to disk is sent over the WAN.

Using the policy engine, Tivoli Storage Manager FastBack sends only the blocks that have changed since the last replication job, which again can be scheduled on a per-application basis. Tivoli Storage Manager FastBack also deploys a range of other performance-enhancing technologies, including multi-threading, compression, and bundling of small files.
Dissimilar hardware bare machine recovery

The ability to get a new server up and running quickly, even if the hardware platform is significantly different from the server that is replaced (including virtual machines) is key in deploying a cost-effective and easy-to-manage business continuity solution. Rather than needing a standby server assigned to every critical server in the company, you now only need to have enough to cover the worst possible contingency.

For example, if you have 10 regional and local offices and assume that only one might go offline at a time, you need only enough servers standing by to cover the biggest office. In addition, because these servers can have generic hardware, you do not need to worry about keeping them up-to-date with the production servers. Also, this technology is excellent for migrating from existing servers to new platforms. Migration times can be cut by more than 50% over traditional migration processes.
Solution environment

This chapter explains IBM Tivoli Storage Manager FastBack solution environments. We describe the combined hardware and software prerequisites, planning considerations and recommendations for the FastBack subcomponents. This chapter includes the following topics:

- 2.1, “Requirements of Tivoli Storage Manager FastBack” on page 24
- 2.2, “Tivoli Storage Manager FastBack sizing and operational considerations” on page 30
- 2.3, “Tivoli Storage Manager FastBack readiness checklist” on page 33
- 2.4, “Typical deployment environment” on page 35
2.1 Requirements of Tivoli Storage Manager FastBack

The requirements in this section are recommendations for typical production environments. Hardware requirements vary and depend on the following configuration characteristics:

- Number of protected servers
- Number of protected volumes
- Data set sizes
- LAN and SAN connectivity
- Repository disk throughput
- Use of Continuous Data Protection (CDP) operations

2.1.1 Tivoli Storage Manager FastBack Server requirements

The FastBack Server must meet the following requirements:

- Recommended to use static TCP/IP addresses.
- Boot and Windows partitions must be NTFS formatted.
- Requirements for the repository size are based on one full snapshot and incremental snapshots.
- FastBack Server supports multipath I/O. See also Table 2-2 on page 30.
- When using CDP, resource requirements can be significantly higher.
- Tivoli Storage Manager FastBack Server cannot run on the same machine where Microsoft Exchange runs.

Tivoli Storage Manager FastBack Server hardware requirements

To install Tivoli Storage Manager FastBack Server, your system must meet the following hardware requirements:

- Processor
  - Minimum: 3 GHz Dual Intel® Pentium® or compatible
  - 32-bit support only
  - For better performance or a larger environment: 4 GHz Dual Intel Pentium® or compatible

- Memory
  - Minimum: 2 GB RAM, 2 GB Virtual Memory
  - For better performance or a larger environment: 3 GB RAM, 2 GB Virtual Memory
Available hard disk

- 100 MB for FastBack Server code
- 200 MB for the Documents and Settings folder
- Additional storage requirement for FastBack repository (see 2.2.1, “Tivoli Storage Manager FastBack Server and repository” on page 30 for more information)

**Tivoli Storage Manager FastBack Server software requirements**

FastBack Server supports the following Microsoft Windows operating systems:

- Microsoft Windows 2003 Standard Server and Enterprise Server, Service Pack 1 or later, 32-bit
- Windows 2003 SP2 or Windows 2003 SP1 with hot fix for kb931319 are required for the installation of FastBack Restore Disaster Recovery component with File Exchange Protocol (FXP)
- Microsoft Windows XP Professional Edition, Service Pack 1 or later

Remember that boot and Windows partitions must be formatted on NTFS.

**2.1.2 Tivoli Storage Manager FastBack Client requirements**

The computer that you use as a FastBack restoration server must meet the following requirements:

- FastBack Client does not support NT Volume management.
- Only snapshots of NTFS volumes can be used for file-level restoration.
- Do not install FastBack Client on the FastBack server.
- FastBack Client supports multipath I/O.
- CDP resource requirements can be significantly higher.

**Tivoli Storage Manager FastBack Client hardware requirements**

To install FastBack Client, your system must meet the following hardware requirements:

- Processor
  - Minimum: 733 MHz Dual Intel Pentium or compatible
  - For better performance or a larger environment: 1 GHz Dual Intel Pentium or compatible
  - Support for AMD64/EM64T and IA64 in 64-bit operating system
Memory
- Minimum: 512 MB RAM, 2 GB Virtual Memory
- For better performance or a larger environment: 1 GB RAM, 3 GB Virtual Memory

Available hard disk
- 200 MB for the Documents and Settings folder

**Tivoli Storage Manager FastBack Client software requirements**

FastBack Client supports the following Microsoft Windows operating systems:

- Microsoft Windows 2000 Standard Server, Advanced Server, and Professional Editions, Service Pack 3 or later
- Microsoft Windows 2003 Standard Server and Enterprise Server, Service Pack 1 or later
- Microsoft Windows 2003 64-bit Edition (AMD64/EM64T and IA64)
- Microsoft Windows XP Professional Edition, Service Pack 1 or later

**Note:** These requirements also apply to the Administrative Command Line, FastBack Mount, and Instant Restore modules.

**Microsoft SQL Server software requirements**

You must also have one of the following versions of Microsoft SQL Server® installed:

- Microsoft SQL Server 2000 Enterprise Edition with Service Pack 2 or later on Windows 2000 Server with Service Pack 4 or Windows 2003 Enterprise
- Microsoft SQL Server 2005 Enterprise Edition
- SQL servers of the above mentioned versions in a clustered environment

**Note:** If both Microsoft Exchange Server and Microsoft SQL Server are concurrently installed on the same computer, you must create a dedicated policy to back up each server individually.
2.1.3 Tivoli Storage Manager FastBack for Microsoft Exchange software requirements

FastBack for Microsoft Exchange currently supports the following Microsoft Exchange applications:

- Microsoft Exchange 2000
- Microsoft Exchange 2003
- Microsoft Exchange 2007

FastBack for Microsoft Exchange supports only 32-bit X86 and 64-bit X64 or IA64 architectures. One of the following operating systems is required:

- Windows XP Professional SP 1 or later
- Windows 2003 Standard Server SP 1 or later
- Windows 2003 Enterprise Server SP 1 or later

**Note:** Do not install FastBack for Microsoft Exchange on the Exchange server. Install it on a separate system with Outlook® client installed. For more information, refer to 4.5, “Installing Tivoli Storage Manager FastBack for Microsoft Exchange” on page 64.

2.1.4 Tivoli Storage Manager FastBack for Bare Machine Recovery requirements

Tivoli Storage Manager FastBack for Bare Machine Recovery supports the following processor environments:

- Intel x86 processors (32 bit) with Windows 32-bit operating systems.
- Intel x64 (AMD64 and EM64T) processors with Windows 64-bit operating systems
- Tivoli Storage Manager FastBack does not support Bare Machine Recovery on Itanium®.

2.1.5 Tivoli Storage Manager FastBack Server repository considerations

The repository is one of the key elements in Tivoli Storage Manager FastBack installation. FastBack Server supports several types of repositories, including volumes and network folders (shares) in addition to local drives (DAS or SAN). Network folders allow utilization of any available free storage space within the organization by using devices such as Network Attached Storage (NAS) or other network share options.
Consider the following characteristics for planning purposes:

- The entire disk selected is used as repository.
- During FastBack initialization a single partition is created on the disk and all data is deleted.
- FastBack creates special signatures on the master boot record (MBR) sector (sector 0) on the disk. Thus, you need to:
  - Protect the volume from accidental formats or initialization.
  - Allows restorations over the SAN (if the Repository resides on a SAN).
- To re-use a repository disk for normal operating system operation, you need to reformat it. (Only Windows formatting removes FastBack signature on disk.)

Before you begin the installation process, the following requirements must be met:

- At least one of the following disks must be available for the repository:
  - IDE
  - SCSI
  - LUN in the SAN
- Tivoli Storage Manager FastBack support for Windows Dynamic Disk is limited to Simple Volumes. Spanned, Mirrored, Striped, and RAID-5 Dynamic Volumes are not supported at this time, and using them can result in corrupted data.
- Continuous Data Protection is not supported on dynamic volumes and disks such as RAID 5, mirror, and striped disks
- GUID Partition Table (GPT) disks are not supported and, therefore, are handled improperly. The disk data that displays is erroneous.
- Any number of LUNs in the SAN, DAS, or SCSI can be snapped or allocated to the repository at any time.
- For the SAN environment, assuming that the servers and the disks are already connected to the SAN switch with correct zoning before installing FastBack Server, you must have a Fibre Channel switch with at least one available port reserved for the FastBack Server or a direct SAN connection.

Note: Tivoli Storage Manager FastBack supports a mix of different types of disk storage (such as SAN and DAS together with NAS and folder in one repository). However, this mix is not recommended due to the different access and performance characteristics. For more information, see Table 2-1 on page 29.
The system that runs FastBack Mount or Instant Restore must have access to the repository through either the SAN (by direct access to disk) or LAN (by connecting to the shared repository on the FastBack Server).

Table 2-1 lists the different types of technology that can be attached as a disk repository to FastBack server.

Table 2-1  Discussion of repository disk types

<table>
<thead>
<tr>
<th>Location</th>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
</table>
| Local hard drive | ▶ Stand-alone dedicated storage for images  
▶ Can detect file system corruptions and recovery  
▶ Inexpensive  
▶ Fast compared to network disks  
▶ Accurate capacity management  
▶ Central management | ▶ Vulnerable, no fault tolerance  
▶ A dedicated disk is required  
▶ Only MS® Basic disk |
| SAN storage     | ▶ Fault tolerant managed  
▶ Can detect FS corruptions and recovery  
▶ Instant recovery over the SAN by any machine connected to the SAN  
▶ Accurate capacity management  
▶ Central management | Expensive |
| Network storage | Storage agnostic, NAS or any network location | ▶ Appropriate accesses rights must be assigned  
▶ Capacity management is not accurate  
▶ No detection of detect FS corruption or failures  
▶ No central management |
| Volume or folder | ▶ Flexibility, no need for special dedicated disk  
▶ Can be on MS Dynamic Disk with MS fault tolerant, for example Mirror or RAID5 | ▶ Access rights must guarantee exclusive write access only for FastBack server  
▶ No accurate capacity management  
▶ No central management  
▶ Must be large enough to hold snapshot (full or incremental)  
▶ A large number of volumes or folders can harm the restoration and recovery performance |

Table 2-2 lists the tested SAN device-driver configurations. (This table shows the status as of 3Q08. Refer to product support pages for information about any updates.)
2.2 Tivoli Storage Manager FastBack sizing and operational considerations

This section discusses the sizing recommendations and limits that you need to consider when planning Tivoli Storage Manager FastBack installation.

Table 2-2  FastBack tested SAN device drivers

<table>
<thead>
<tr>
<th>Disk-System</th>
<th>Driver</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM DS3400</td>
<td>RDAC IBM 9.1.35.38</td>
</tr>
<tr>
<td>IBM DS4300</td>
<td>RDAC IBM 9.1.35.38</td>
</tr>
<tr>
<td>IBM DS8000™</td>
<td>SDD IBM 1.6.3</td>
</tr>
<tr>
<td>SVC (and multipath I/O)</td>
<td>SDD IBM 1.6.3</td>
</tr>
<tr>
<td>EMC Clarion (and MetaVolume)</td>
<td>PowerPath 5.0.0.910</td>
</tr>
</tbody>
</table>

Note: The sizing limits can change, depending on the frequency of snapshots, the size of the volumes, retention, and other parameters. In general, if you use CDP operation, you must increase the requirements. We recommend 2 to 5 times more.

2.2.1 Tivoli Storage Manager FastBack Server and repository

Consider the following limits in your project sizing:

- Maximum number of protected FastBack clients per FastBack server is 40.
- Maximum size of total repository size per FastBack server is around 15-20TB, this relates to total FastBack client protected data size of around 4TB. The data in the repository is around 3 to 5 times the size of actual protected data.
- Minimum bandwidth between FastBack server and the FastBack Clients is 100 Mb.
- Minimum bandwidth between the FastBack server and the repository is 1 Gb Ethernet (when NAS or network disks are used).
- Snapshots over WAN connections are not supported. There must be a FastBack server installed locally.
- A snapshot restoration over the WAN is also not supported (if the local FastBack Server is down). You must do a local restoration in the central
disaster recovery site and then transport the restored server back into the remote office.

- FastBack backs up individual VMware® virtual machines as if it is a real server with the following limitation:
  - It does not integrate with VMware Consolidated Backup nor ESX Server.
  - It cannot use SAN disks as a repository from within a guest.

- FastBack Server supports attachment of up to 20 repository objects to one repository. A mix of types is also possible according to the type limitation, as follows:
  - Size the space at two to five times the size of your data that will be backed up. The more generations of backup data that you need to manage, the more space is required. As a planning gauge, 30 days usually equates to 3.5 times space requirement.
  - Each new FastBack policy creates first a full snapshot, not considering that there might be other full snapshots from that client already stored within other policies. So, be careful in defining different snapshot policies for the same client or client group.

- Repository sizing for CDP backup must be estimated depending on the data update rate of the monitored disk. When the data changed 10% per day, you can assume that the CDP images has an additional 15% of repository space.

### 2.2.2 Tivoli Storage Manager FastBack Disaster Recovery Hub Server

Consider the following limits in your project sizing:

- Maximum number of branches per FastBack hub server is 20.
- Storage requirements for the hub or disaster recovery site include:
  - The sum of all repository sizes. If selective replications occur, this number can change.
  - The requirements of the staging area. Size is the sum of the biggest volume from each branch.

Table 2-3 illustrates an example of this requirement calculation.

<table>
<thead>
<tr>
<th>Site</th>
<th>Repository size</th>
<th>Largest volume size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Branch A</td>
<td>2 TB</td>
<td>250 GB</td>
</tr>
<tr>
<td>Branch B</td>
<td>3 TB</td>
<td>500 GB</td>
</tr>
<tr>
<td>Branch C</td>
<td>2 TB</td>
<td>160 GB</td>
</tr>
</tbody>
</table>
Based on Table 2-3, the total repository size is 7 TB + 910 GB as the staging area, or approximately 8 TB.

### 2.2.3 Connecting the Tivoli Storage Manager FastBack server with the Tivoli Storage Manager Client

Take into consideration the following facts when you connect the Tivoli Storage Manager FastBack server with FastBack Client:

- Do not use the Tivoli Storage Manager backup/archive client to back up the FastBack repository. The FastBack internal cleanup processes might relocate data objects within the repository disks that are invisible to Tivoli Storage Manager.

- Backing up the contents of FastBack repository or FastBack hub server replicated repository content by using Tivoli Storage Manager backup/archive client (using FastBack Mount) will take a full backup of the application or database files. (Tivoli Storage Manager backup/archive client is not application-aware when backing up the repository and FastBack hub server disk container files.)

- Backing up the contents of FastBack backups using Tivoli Storage Manager backup/archive client cannot exploit journal-based backups or sub-file backups.

- The Tivoli Storage Manager FastBack integration is currently supported by a number of scripts and manual configuration tasks in the Tivoli Storage Manager server. Updates on the client configuration on FastBack Server always must result in changes within the scripts and Tivoli Storage Manager node definitions.

- The backup process performance of the integrated FastBack Disaster Recovery Hub with Tivoli Storage Manager backup/archive client using FastBack Mount is lower than a native Tivoli Storage Manager backup/archive client. You need to test the performance in your environment.

The performance and scalability of the solution will depend on the following factors:

- System throughput capabilities of the FastBack server or FastBack Disaster Recovery hub server. The disk repository, CPU, and memory are all variables that can affect overall system throughput.
– The number of concurrent Tivoli Storage Manager backup/archive client or FastBack Mount sessions.

– The amount of activity on the FastBack server. Mounting a snapshot for Tivoli Storage Manager integration prevents cleanup from running. This lack of cleanup can also affect overall performance of the backup server. For example, FastBack Mount can use 50% of the underlying disk system throughput, which can affect running snapshots and replication.

– The amount of data that is backed up and frequency of snapshots.

Based on your environment and configuration, develop guidelines for usage, such as:

– Assume 50% reduction in backup throughput compared to native Tivoli Storage Manager client backup performance.

– Restrict daily full backups to no more than 500 GB.

– Restrict weekly full backups to no more than 2 TB.

– Restrict the amount of daily incremental backups to no more than 7 TB.

### 2.3 Tivoli Storage Manager FastBack readiness checklist

This section lists the key readiness tasks that you need to complete before you can run Tivoli Storage Manager FastBack in your environment. You need to perform these tasks to verify that your environment is ready to run Tivoli Storage Manager FastBack.

### 2.3.1 Tivoli Storage Manager FastBack mandatory considerations

The following are some mandatory items to consider when implementing Tivoli Storage Manager FastBack:

> **FastBack repository volume**

Define a basic volume allocation on the FastBack server. Do not create a partition on the volumes that you want to use for the FastBack repository. Thus, there should be no drive letter associated with this space at this time. For information about sizing the repository, see 2.2.1, “Tivoli Storage Manager FastBack Server and repository” on page 30.

> **Page volume considerations**

The repository volume’s disk drive cannot have any operating system paging volume defined on it, which prevents Instant Restore.
FastBack Server 32-bit support

FastBack Server is supported at 32-bit only at this time. Use a 32-bit Windows operating system image.

Adobe® Acrobat® Reader

The product documentation is supplied in the FastBack code image. You need Acrobat Reader installed on the system to open and use these documents. Install Acrobat Reader on the FastBack server, disaster recovery server, and clients as appropriate and where desired.

Application and file system readiness

Based upon what you want to do in FastBack (such as backup file systems or backup Exchange), you need to ensure the readiness and availability of those systems in the target FastBack environment. Prepare in advance at least one expendable system of each type that you want to restore using FastBack. If you are deploying in a test environment, then create these images in the test environment prior to deploying FastBack, because imaging servers can take hours or even days of elapsed time to accomplish.

2.3.2 Tivoli Storage Manager FastBack optional considerations

The following considerations are needed depending on your environment:

- Using FastBack hub functionality
  The FastBack server and the FastBack hub server communicate using FTP. Configure your systems to use FTP, and test FTP file transfer from the FastBack server to the hub server to verify that this function is successful. Verify that you can create, list, and delete files on the hub server.

- Restoring Exchange (base level)
  Exchange User & Mail Considerations. During testing, either replicate/mimic the Exchange environment from your organization, or create some sample users and mail items.

Note: Any system object (page file, system files, Active Directory files, or registry files) that must be opened prevent FastBack from doing a clean volume restoration while the operating system is running. These objects must be restored using the Bare Machine Recovery CD or using a 2-step process that does an NTBackup of system files to a dump file, which is then protected by FastBack.
2.4 Typical deployment environment

Based on the architecture of Tivoli Storage Manager FastBack that we discussed in Chapter 1, “Solution introduction” on page 3, this section discusses the following deployment scenarios:

- A single location with or without a remote site
- Multiple locations with a central disaster recovery site

2.4.1 A single location with or without a remote site

A small scale deployment environment for a Tivoli Storage Manager FastBack solution can be an isolated installation with or without replication to a central disaster recovery site, as illustrated in Figure 2-1. You need the following FastBack components for this scenario:

- FastBack Server
- FastBack Manager
- FastBack Client
- FastBack Mount

- Restoring Exchange (individual mailbox recovery level)

FastBack for Microsoft Exchange provides the individual mailbox recovery (IMR) functionality and requires Outlook in the environment. If your organization runs Outlook, install it in this environment. Without Outlook, FastBack for Microsoft Exchange cannot log into Exchange and, therefore, cannot restore messages directly back into Exchange.

- Creating the FastBack Bare Machine Recovery CD

FastBack Bare Machine Recovery needs a bootable CD that contains a modified WinPE image. The preparation of that CD is done by several customization steps, which we describe in 4.7, “Preparing Tivoli Storage Manager FastBack for Bare Machine Recovery” on page 94.

- Installing 64-bit FastBack clients

The FastBack Client can run on 32-bit or 64-bit. When running on 64-bit, a known issue might arise when the 64-bit operating system is imaged or cloned, setting the SID, resulting with Microsoft Volume Shadowcopy (VSS) inoperational. This is a known issue for various software products, including FastBack. For more information, see 6.2.3, “Integration considerations” on page 185 for detailed description and test.
FastBack for Microsoft Exchange
FastBack for Bare Machine Recovery
FastBack Disaster Recovery Hub Server and Central Control Station (optional)

This environment is characterized by Windows file servers and application servers that are running in a local LAN or that are sharing disk resources within a SAN with the FastBack server. Each client that is eligible for FastBack services must have an appropriate FastBack client installed (FastBack Client or Tivoli Storage Manager FastBack Client for Microsoft Exchange.)

If you need FastBack services for operating system recovery, then you must use FastBack for Bare Machine Recovery to generate boot CDs for each eligible system (for individual hardware configurations). The book CDs enable you to recover from system failures using previous snapshot backups for recovery.

Optionally, you can install a FastBack hub server in a different building or geographical site to help protect the local site from disasters. The hub server typically includes FastBack Hub Server, Central Control Station, and optionally FastBack Mount for local restores on the disaster recovery site.

2.4.2 Multiple locations with a central disaster recovery site

This setup is a typical environment for enterprise customers with a branch office infrastructure to support. Figure 2-2 shows an example of an “n to 1” Tivoli Storage Manager FastBack installation with optional integration into Tivoli Storage Manager for moving snapshot data to tape.
You need the following FastBack components for this scenario:

- FastBack Server
- FastBack Manager
- FastBack Client
- FastBack Mount
- FastBack for Microsoft Exchange
- FastBack for Bare Machine Recovery
- FastBack Hub Server
- FastBack Central Control Station
- Tivoli Storage Manager backup/archive client
- Tivoli Storage Manager Server

This deployment environment is characterized by multiple FastBack Server installations in different geographical locations, all replicating to one central site.

The FastBack hub server in the central site (the data center) is configured to keep the total amount of these snapshot backups that are defined as required for disaster recovery, which typically is a subset of the amount of data that is kept locally.

In this environment, you can use the FastBack hub server with FastBack Mount to restore machines that are located at the remote offices locally in the data center or to interact with Tivoli Storage Manager backup/archive client to move the data on tape for off site vaulting.

Figure 2-2  Multiple remote offices and one central disaster recovery site
It is possible that due to the amount of data in the remote offices or the number of remote offices to be served, replication to a single FastBack disaster recovery hub server is not possible according to the sizing limits recommended in 2.2.2, “Tivoli Storage Manager FastBack Disaster Recovery Hub Server” on page 31. In this case, the deployment scenario would use horizontal scalability requirements and dedication of a defined number of remote offices to several FastBack hub servers.
Project planning

This chapter discusses the necessary preparation for running a deployment project for IBM Tivoli Storage Manager FastBack. It includes the following topics:

- 3.1, “Required skills” on page 40
- 3.2, “Solution description” on page 41
- 3.3, “Implementation task breakdown” on page 41
3.1 Required skills

For implementation of Tivoli Storage Manager FastBack V5.5, the project team needs the following basic skills:

- Operating system skill for Windows 2003
- Good understanding of Windows security model, domain concept and Active Directory
- Application knowledge of the environment that you must support (such as Microsoft Exchange and Microsoft SQL Server) and an understanding of how to implement consistent backup support without having application-aware support from FastBack clients (such as Lotus® Domino®, Oracle®, and DB2®)
- Network configuration skills for LAN and WAN
- Knowledge of SAN configuration and dependencies (if implemented)
- Scripting knowledge in a Windows environments

In addition to these requirements, you must understand the Tivoli Storage Manager FastBack architecture, as well as the value of its components and features, including:

- Planning, installing, and configuring FastBack Server and its repository disks
- Installing and configuring FastBack Client, FastBack Exchange client, FastBack Mount, and FastBack Bare Machine Recovery
- Understanding the differences of full and incremental volume snapshots, file recovery, instant recovery, and continuous data protection mode
- Planning, installing, and configuring FastBack Disaster Recovery Hub Server, Central Control Station, and other required components on the central disaster recovery site
- Tivoli Storage Manager backup/archive client and Tivoli Storage Manager server skills if you are planning for Tivoli Storage Manager integration

You can also use *Tivoli Storage Manager FastBack Installation and User’s Guide*, SC23-8562 to get more information about these items.
3.2 Solution description

Tivoli Storage Manager FastBack solution performs the following functions:

- Offers backup services for several Windows machines on one consolidated backup server over LAN or SAN:
  - File system backups
  - Application backups
  - Bare machine recovery
  - Replication to a vault location

- Provides different methods of performing file and application snapshot backups:
  - Full volume snapshots
  - Block-incremental snapshots
  - Scheduled or manually initiated snapshots
  - Continuous data protection

- Offers granular alternatives of data recovery in the local branch or, if configured, in the disaster recovery site:
  - Volume snapshot restoration
  - Single file recovery using temporary mount of selected snapshot
  - Instant recovery

- Provides replication services for transferring the data of remote branches into one central disaster recovery location

3.3 Implementation task breakdown

The detailed tasks to implement Tivoli Storage Manager FastBack are divided into the follow stages:

- Project kick-off
- Data collection
- Environment preparation
- Installing the Tivoli Storage Manager FastBack components
- Demonstrating the solution and skill transfer

3.3.1 Project kick-off

The kick-off of the project is a critical task where the project team members are identified, the roles and responsibilities are presented and allocated, project entry and exit criteria is defined, and a generic project plan is determined.
The kick-off is also an important milestone to promote the project to the users of that solution to generate interest for that project.

### 3.3.2 Data collection

Data collection must be performed to design and configure the solution correctly. You can use different approaches to gain all of the necessary information:

- List the backup data sources and their access methods to get the user’s data for sizing purposes. Some configuration requires a certain FastBack feature to be enabled and certain authority might be needed.
- Learn from customer the expectations for Recovery Point Objectives (RPO) and Recovery Time Objectives (RTO) and discuss whether these expectations are feasible with the hardware configuration provided.
- Identify the granularity of backup requirements from the customer to calculate the data space requirements correctly.
- Understand the customer’s branch office structure to define correctly the common and unique elements.
- Identify the customer’s disaster protection requirements and reporting needs.

Based on the requirements that the customer defines, you can start developing the solution configuration. The configuration defines the layout for the critical components as the FastBack Server or FastBack Hub Server, which are the necessary resource and repository definitions and bandwidth assumptions. It includes a review of the available licenses.

### 3.3.3 Environment preparation

The initial environment preparation has the following objectives:

- Installing and preparing the new FastBack server with the appropriate operating system, network connectivity, and disk resources.
- Identifying server machines where the FastBack clients will be installed.
- Collecting installation media and required software for the installation.
- Collecting information about the Active Directory Domain structure of the different FastBack components and configure it accordingly.

Depending on the size of the implementation, the duration for disk formatting, and the required readiness of the environment, these steps can take several hours up to a few days to complete.
3.3.4 Installing the Tivoli Storage Manager FastBack components

When all the preparation is complete, you can install the components. We discuss the components installation in detail in Chapter 4, “Installation and configuration” on page 49.

In this section, we provide an overview of installing the following components:

- Tivoli Storage Manager FastBack Server setup
- Tivoli Storage Manager FastBack Client setup
- Tivoli Storage Manager FastBack Disaster Recovery Hub Server setup
- Setting up additional functions

You can also find additional information in the following manuals:


The following Web sites might also be helpful:


**Tivoli Storage Manager FastBack Server setup**
Installation is performed using the installation wizard. Remember that during FastBack Server installation FastBack Manager and FastBack Mount are also installed on that machine. After server installation and reboot, you start FastBack

**Note:** FastBack components do not need any license keys for installation or operation. Therefore, before you begin the installation process, validate whether the required license contracts are signed. If not, contact your IBM or Business Partner sales representative immediately.
Server, and you are requested to configure the first repository disk to the server. Without at least one repository disk allocated and initialized, the server will not operate.

It is recommended that you change the default password for FastBack Server. The default password for user admin is admin123.

If FastBack clients are already installed and configured, you can see these clients and define client groups, schedules, and policies. Otherwise, perform these configuration of client group, schedules, and policies after installing and configuring the clients.

**Tivoli Storage Manager FastBack Client setup**

Client installation is performed using the installation wizard. Depending on the customer requirements, you can also install FastBack Mount (which includes Instant Restore) to be able to do single file restores and exploit the Instant Restore capabilities.

Run the FastBack Configurator to identify and register the client with the FastBack server. For applications except Microsoft Exchange perform necessary pre/post-script configuration to ensure consistent data during snapshot backup.

**Tivoli Storage Manager FastBack Disaster Recovery Hub Server setup**

FastBack Hub Server typically installs in geographical distance to the FastBack server. So the project must reflect the necessary travel time between the different locations in the project schedule or divide the installation responsibility into different project groups.

You also need to check whether the necessary network bandwidth is available between the FastBack servers and FastBack hub server to ensure that the replication window ends in the expected time frame.

If running in a multiple branch office configuration, FastBack disaster recovery hub server typically must provide more disk storage resources than the FastBack servers in the individual branches, because it contains selected snapshots from all the branches. So, plan carefully your snapshot configuration in each branch and provide enough storage resources to the FastBack disaster recovery hub server.

You need to expand the FastBack disaster recovery hub server installation by installing Central Control Station and optional FastBack Manager for remote management of the FastBack servers in the branches and by installing FastBack
Mount to recover branch clients locally in the central site in case the branch office FastBack server is inaccessible due to a disaster.

**Setting up additional functions**
You can set up the following optional functions to facilitate specific backup and recovery conditions:

- Set up FastBack for Microsoft Exchange to manage recovery of Exchange server individual mail objects. Install and configure FastBack for Microsoft Exchange as described in 4.5, “Installing Tivoli Storage Manager FastBack for Microsoft Exchange” on page 64.

- Set up the Bare Machine Recovery CD to recover a server to the same or different machine without having to install the operating system. For this function, you have to create a boot CD image according to the description in 4.7, “Preparing Tivoli Storage Manager FastBack for Bare Machine Recovery” on page 94.

**Note:** Remember that the code required for generating the Bare Machine Recovery CD is a collection of different utilities and the Windows Automated Installation Kit from the Microsoft download area. The current WinPE image is about 950 MB in size. Therefore, plan for adequate download time and have a DVD-burner device at the installation site. The FastBack Bare Machine Recovery CD uses a subset of the WinPE image that is typically around 200 MB.

### 3.3.5 Demonstrating the solution and skill transfer

After the customization is complete and the FastBack solution is in place, such as for a previously defined set of branches and central disaster recovery location, you can demonstrate the result to the customer. This demonstration can serve as your completion milestone. You must also document the configuration to reflect that the exit criteria defined at the start of the project are met or why the criteria was changed.

Then, plan for skill transfer sessions or preparation of education material, so that the customer's personnel can operate and maintain the solution on a day-to-day basis or can deploy to other locations with the solution.

We discuss the demonstration tasks in Chapter 5, “Usage demonstration” on page 109.
Part 2

Implementation

In this part, we discuss how to implement IBM Tivoli Storage Manager FastBack. We also provide usage scenarios. The chapters in this part are:

- Chapter 4, “Installation and configuration” on page 49
- Chapter 5, “Usage demonstration” on page 109
- Chapter 6, “Best practices and troubleshooting tips” on page 171
Chapter 4. Installation and configuration

This chapter explains how to install and configure the IBM Tivoli Storage Manager FastBack client and server. It includes the following topics:

- 4.1, “Installation overview” on page 50
- 4.2, “Installing Tivoli Storage Manager FastBack Server” on page 51
- 4.3, “Installing Tivoli Storage Manager FastBack Client” on page 58
- 4.4, “Installing Tivoli Storage Manager FastBack components independently” on page 61
- 4.5, “Installing Tivoli Storage Manager FastBack for Microsoft Exchange” on page 64
- 4.6, “Installing Tivoli Storage Manager FastBack Hub Server” on page 78
- 4.7, “Preparing Tivoli Storage Manager FastBack for Bare Machine Recovery” on page 94
4.1 Installation overview

The chapter takes you through the standard installation procedure to produce a complete working environment for Tivoli Storage Manager FastBack. Figure 4-1 shows the Tivoli Storage Manager FastBack environment that we used in our testing for this book.

![Test environment detail](image)

Our test environment included the following components:

- Active Directory server also running DNS with a single domain called *TI8T61*. This machine also acted as the Tivoli Storage Manager server.
- One member server acting as the FastBack Hub server with Tivoli Storage Manager backup and archive client.
- One member server with FastBack Server installed.
- Member servers with the following applications installed:
  - File server
  - VMware images
  - Microsoft Exchange
  - Microsoft SQL Server
All the servers used Windows 2003 Standard Edition servers with Service Pack 2 loaded. Installations for FastBack were performed with administrator rights in the Active Directory.

4.2 Installing Tivoli Storage Manager FastBack Server

This section discusses how to install Tivoli Storage Manager FastBack Server. One of the key elements for FastBack is the disk repository and its configuration. Before installing, refer to 2.2, “Tivoli Storage Manager FastBack sizing and operational considerations” on page 30.

Note: Before installing the FastBack server on a SAN attached system, do not allow any disks to be visible to the FastBack server, except for the disk that it is own, until after you install FastBack on both the server and the clients. Until FastBack is installed, if you map some FastBack client disks to the FastBack server for serverless backup, the FastBack server host might corrupt the client’s file system.

Likewise, do not allow any FastBack client host to see the FastBack server’s repository disk until after you install FastBack. Reconnect the system only after FastBack Server is installed and you restart the system. Disks that are added to the FastBack server after the FastBack Server is installed are read-only or can serve as repository disks.

From the installation source, select the correct directory for the system type. For example, the directory x86 contains the 32-bit Windows setup code. Then, to install Tivoli Storage Manager FastBack Server, follow these steps:

1. Double-click setup.exe. In the language selection dialog box (shown in Figure 4-2), select an installation language from the drop-down menu, and click OK.

Figure 4-2 Language selection
2. After the installation code loads, a welcome window displays, as shown in Figure 4-3. Click Next to continue.

Figure 4-3 Welcome window
3. Read the license agreement, and if you agree to the terms, click **Yes**, as shown in Figure 4-4.
4. Click **Next** to install Tivoli Storage Manager FastBack Server at the default location, as shown in Figure 4-5. To change to another directory, click **Browse**, and select another directory before you click **Next**.

![Figure 4-5   Path selection](image)
5. Now, select the type of installation. In this example, choose **Backup Server** as shown in Figure 4-6. Click **Next** to continue.

*Figure 4-6  Server installation type*
6. Tivoli Storage Manager FastBack installs a device driver to intercept and manage disk access. Click **Yes** to accept the driver, as shown in Figure 4-7.

![Security Alert - Driver Installation]

The driver software you are installing for:

FBVW Driver

has been signed with Authenticode(TM) technology. The publisher's identity has been verified, and the driver has not been modified since it was published.

Published by: IBM Corporation
Date published: 8/7/2008
Publisher authenticity verified by VeriSign Class 3 Code Signing 2004 CA

However, this driver cannot be tested by Microsoft Windows Hardware Quality Labs to verify its compatibility with this version of Windows. [Tell me more about this testing.]

Do you trust this publisher and want to install the driver?

---

**Figure 4-7  Driver warning**
7. Click **Yes** to restart the computer after installation is complete, as shown in Figure 4-8. Then, click **Finish**.

The FastBack Server components run as Windows services. Before starting FastBack Manager, you need to start the following services:

- FastBack Mount
- FastBack Server
- FastBack WatchDog

The startup type is Automatic.
4.3 Installing Tivoli Storage Manager FastBack Client

The client uses the same installation code and wizard as FastBack Server installation, which we discussed in 4.2, “Installing Tivoli Storage Manager FastBack Server” on page 51. However, you need to select a different installation component in step 5 on page 55. For the installation component, ensure that **Backup Client** is selected, as shown in Figure 4-9.

![Select Backup Client](Image)

*Figure 4-9  Select Backup Client*
The default client installation installs FastBack Manager. FastBack Manager requires connection to the FastBack server host name or IP address, as shown in Figure 4-10.

![Figure 4-10 FastBack server selection](Image)

Enter the name of the FastBack Server
(if a static IP Address is used, enter the IP Address)

NEWHOPE

The installation then continues as discussed previously in 4.2, “Installing Tivoli Storage Manager FastBack Server” on page 51. See steps 6 on page 56 and 7 on page 57.
When the client reboots, you can configure the client to connect to a specific FastBack server. The dialog box has basic and advanced options that you can toggle using F10. See Figure 4-11.
4.4 Installing Tivoli Storage Manager FastBack components independently

The basic installation of Tivoli Storage Manager FastBack solution includes the following components:

- FastBack Server
- FastBack Manager
- Administrative Command Line
- FastBack Client
- FastBack Mount
- FastBack Instant Restore
- FastBack Disaster Recovery
- Central Control Station

FastBack can also allow you to install each components selectively. For example, if an administrator wants to set up a separate management workstation to control multiple FastBack servers. They can load elements of the toolset, such as Fastback Manager and FastBack Administrative Command Line to do this. For this selective installation, you have to use the installation type of Advanced as shown in Figure 4-12 on page 62.
Figure 4-12   Advanced Selection

- **Backup Client**
  Select this option to install the FastBack Client software on a production/application server that needs backup protection.

- **Backup Server**
  Select this option to install the FastBack Server software on the dedicated backup server.

- **Disaster Recovery Server**
  Select this option if you are installing on the server that will serve as the target for data replication.

- **Advanced**
  Select this option to manually select the FastBack components to install.
When you use the advanced installation, you are presented with the component selection list as shown in Figure 4-13.
If the FastBack Administrative Command Line or FastBack Manager elements are selected, enter a host name or IP address of the FastBack server, as shown in Figure 4-14.

![Define FastBack Server location](image)

*Figure 4-14  FastBack server location*

Depending on the component that you select, the installation might require a reboot.

### 4.5 Installing Tivoli Storage Manager FastBack for Microsoft Exchange

Before installing Tivoli Storage Manager FastBack for Microsoft Exchange, you must install FastBack Mount and Microsoft Outlook to recover the individual items in each mailbox. You can install FastBack Mount separately using the advanced installation or together with FastBack Client installation.
Chapter 4. Installation and configuration

4.5.1 Configuring Microsoft Outlook

Tivoli Storage Manager FastBack for Microsoft Exchange uses Microsoft Outlook API to access individual mailboxes. You must set up Microsoft Outlook as the default e-mail service as follows:

1. Start the Internet options from Start → Control Panel → Internet Options.
2. Select the Programs tab from the Internet Properties dialog box as shown in Figure 4-15.

![Figure 4-15 Internet options]

3. From the E-mail drop-down list, select Microsoft Office Outlook, and click OK.
Further setup is needed to set up Microsoft Outlook profile. You must add at least one Microsoft Outlook profile as follows:

1. From the Control Panel, select **Mail**.
2. Click **Show Profiles** from the Mail Setup dialog box, shown in Figure 4-16.

![Figure 4-16 Mail Setup](image)

3. From the Mail general setting (Figure 4-17), click **Add** to create a new profile.

![Figure 4-17 Profiles](image)
4. In the **New Profile** dialog box, specify a profile name, and click **OK** (Figure 4-18).

![New Profile Diagram](image)

*Figure 4-18   New Profile*

5. Take the default “Add a new e-mail account” option, as shown in Figure 4-19, and click **Next**.

![Mail Accounts Diagram](image)

*Figure 4-19   Mail Accounts*
6. Select **Microsoft Exchange Server**, as shown in Figure 4-20, and click **Next**.

![](image)

**Figure 4-20  E-mail Accounts**

<table>
<thead>
<tr>
<th>Server Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Exchange Server</td>
<td>Connect to an Exchange server to read e-mail, access public folders, and share documents.</td>
</tr>
<tr>
<td>POP3</td>
<td>Connect to a POP3 e-mail server to download your e-mail.</td>
</tr>
<tr>
<td>IMAP</td>
<td>Connect to an IMAP e-mail server to download e-mail and synchronize mailbox folders.</td>
</tr>
<tr>
<td>HTTP</td>
<td>Connect to an HTTP e-mail server such as Hotmail to download e-mail and synchronize mailbox folders.</td>
</tr>
<tr>
<td>Additional Server Types</td>
<td>Connect to another workgroup or 3rd-party mail server.</td>
</tr>
</tbody>
</table>
7. Enter the name of the Microsoft Exchange Server and the user name, as shown in Figure 4-21. Then, click **Next** and then **Finish**.

*Figure 4-21  Server and user name*
8. The new profile is now in the profiles list, as shown in Figure 4-22. In this example, the profile name is *fastback*.

Figure 4-22  Profile added

9. Click **Apply** and then click **OK** to use the new profile as a default.

Tivoli Storage Manager FastBack for Microsoft Exchange does not verify that the profile information is valid. Work with your Microsoft Exchange administrator for definitions required for profile configuration.
4.5.2 Installing Tivoli Storage Manager FastBack for Microsoft Exchange

Go to the installation directory of the media and perform the following steps to install FastBack for Microsoft Exchange:

1. Double-click **setup.exe** to start the application.
2. When the security warning displays, click **Run**.

![Figure 4-23 Security warning](image)

3. In the language selection dialog box (Figure 4-24), select an installation language from the drop-down menu and click **OK**.

![Figure 4-24 Language selection](image)
4. Select **Next** on the welcome window as shown in Figure 4-25.
5. Read the license agreement, and click **Yes** if you agree to its terms, as shown in Figure 4-26.

![Image of License Agreement]

*Figure 4-26  License Agreement*
6. Select **Next** to accept the default installation path, as shown in Figure 4-27, or click **Browse** to select an alternate path.

![Figure 4-27](image_url)
7. Click **Next** to select the default Program Folder location, as shown in Figure 4-28.

**Figure 4-28  Default Location**
8. Select **Next** to accept the features to install, as shown in Figure 4-29.

*Figure 4-29  Select install features*
9. Check that the Active Directory domain displays in the list of available domains. Select to add Domain Admins or Enterprise Admins to the FX Restore Master group and then select **Next**. See Figure 4-30.

*Figure 4-30  Domain list*
10. To complete the setup, click **Finish**, as shown in Figure 4-31.

![Figure 4-31  Installation complete](image)

### 4.6 Installing Tivoli Storage Manager FastBack Hub Server

To have a central site in the Tivoli Storage Manager FastBack environment, you implement a FastBack hub server. The communication between the FastBack server in a remote location and the FastBack hub server in a central site or on the disaster recovery server is based on extensions to the standard FTP protocol. Therefore, the installation of the FastBack Hub server requires that you install a standard FTP server on the machine that is hosting the FastBack hub server.

In our test environment, we used the FTP server that is provided by Microsoft Windows 2003; however, you can use any FTP server implementation.
To install FastBack Hub Server, you need to complete the following tasks:

- Installing the Windows 2003 FTP server
- Installing FastBack Hub Server
- Configuring FastBack Server Disaster Recovery
- Configuring Central Control Station

### 4.6.1 Installing the Windows 2003 FTP server

You must install an FTP server program on the hub server. In this section, we describe how to install the Windows 2003 FTP server code.

**Note:** Any FTP server that use for the installation of FastBack Hub Server must be licensed.

To install the Windows 2003 FTP server, follow these steps:

1. Select **Start → Control Panel** and then double-click **Add or Remove Programs**. Then, select the **Add/Remove Windows Components** icon.
2. The Window Components Wizard open. Select **Application Server**, and click **Details**, as shown in Figure 4-32.

![Windows Components Wizard](image)

**Figure 4-32 Select application details**
3. Then, select **Internet Information Services (IIS)** and click **Details**, as shown in Figure 4-33.

![Application Server](image)

**Figure 4-33 Select IIS details**

4. Select **File Transfer Protocol (FTP) Service** (see Figure 4-34) and click **OK** to start the installation.

![Internet Information Services (IIS)](image)

**Figure 4-34 Select FTP**
Depending on the previous Windows 2003 installation, you might be prompted to insert the Microsoft Windows installation CD.

5. When the installation process is complete, you configure the FTP server for the FastBack environment. Select **Start** → **Control Panel** → **Administrative Tools** → **Internet Information Services (IIS) Manager**. Then, select **Applications** → **Internet Information Services** → **FTP Sites** → **Default FTP Site** as shown in Figure 4-35.

![Figure 4-35  Select FTP site](Image)
6. In the FastBack DR Server Properties dialog box, select the FTP Site tab and enter a name for the FTP server in the Descriptor field, as shown in Figure 4-36.

![Figure 4-36 Enter FTP server name](image-url)
7. Then, go to the Security Accounts tab and enter a user name and password for FTP administration, as shown in Figure 4-37. You can use any user name; however, this information is needed to customize disaster recovery of the remote FastBack server. See 4.6.3, “Configuring FastBack Server Disaster Recovery” on page 90 for more information.

![FastBack DR Server Properties](image)

**Figure 4-37** Enter FTP user name and password

8. Finally, click **OK** to complete the installation and configuration of the FTP server.
4.6.2 Installing FastBack Hub Server

After the FTP server is installed and configured, you next install FastBack Hub Server. Follow these steps:

1. Insert the FastBack Restore Server Installation CD and start setup.exe.
2. When presented with the installation types as shown in Figure 4-38, select Advanced and click Next.

3. In the Select Features window, shown in Figure 4-39, select FastBack DR Hub Server and all components that you want to install on the disaster recovery site. In our testing, we installed the following components:
   - Central Control Station
     Allows you to have a graphical interface to monitor the hub server operation
   - FastBack Manager
     Allows you to manage remote FastBack servers from the disaster recovery site
– FastBack Mount

Needed for local restores at the disaster recovery site and for tape backup (Tivoli Storage Manager) integration

**Note:** You can also install additional components after the wizard completes. If you install components on top of already installed components, keep in mind to leave the installed component selected (checked “✓”) in the installation window. Clearing the checkmark for a component will uninstall that component.

![Select Features](image)

*Figure 4-39 Select components to install*
4. After the installation completes, you must reboot the machine by selecting **Yes** and then **Finish** as shown in Figure 4-40.

![Figure 4-40 Restart hub server machine](image)

5. After rebooting the machine, you need to configure FastBack Hub server.

You need to define a disk resource for the snapshot replication. This resource can be a folder, NAS disk, SAN, or a directly attached disk. It is where the replicated data of all remote FastBack servers is stored. In our test environment, we used a folder. The resource must be large enough to keep the desired amount of replicated data. However, it is not a repository in FastBack server terms. Thus, it must be NTFS-formatted by Windows before you can use it.

We used c:\DRrepository for our testing, and within this folder we defined the following directories, as shown in Figure 4-41 on page 87:

- Logs
- Logevents
- REP_BranchName
**Note:** The REP_BranchName folder is named after the branch name with a REP_ prefix. The name of the folder must match the value that you provide in the DR Configuration tab as the branch name. For more information, see 4.6.3, “Configuring FastBack Server Disaster Recovery” on page 90.
6. Edit the file FastBackDRHubServer.ini which resides in the \\Program Files\\Tivoli\\TSM\\FastBack\\drhub directory. See Figure 4-42.

![Image of folder structure]

*Figure 4-42  Location of the FastBack FastBackDRHubServer.ini file*

In the FastBackDRHubServer.ini file, fill in the fully qualified name of the root directory that you generate previously (such as c:\DRrepository) in the fields ListenPath1 and FTPRootPath1. The index determines the number of FTP processing threads to run. If you have additional FastBack servers, you might need additional threads. Typically, you want the same number of threads as the number of CPUs in the system.

**Note:** You must remove the semi-colon comment character at the beginning of each line for the line to be in effect. Remember to put the same folder names in both ListenPath\(n\) and FTPRootPath\(n\) for the same same index number.
7. Now restart the FastBack hub server using the following commands:

   NET STOP “FastBack Hub server Service”
   NET START “FastBack Hub server Service”
4.6.3 Configuring FastBack Server Disaster Recovery

You can configure individual FastBack servers to connect to the hub site using FastBack Manager, which is installed on the hub server. Follow these steps:

1. From the FastBack Manager, click **General Configuration** in the menu structure of the FastBack Restore Server. Then, select the DR Configuration tab as shown in Figure 4-44.

![Figure 4-44 Configuration window for FastBack disaster recovery](image-url)
2. On the DR Configuration tab complete the following information:
   a. Specify the replication destination where the FTP server resides in the Server field. Enter either the FTP server name or its IP address.
   b. Enter the Username and Password as you entered them previously on the FTP server, see Figure 4-37 on page 83.
   c. Enter the branch name, which must match the folder name that you defined in Figure 4-41 on page 87 without the REP_ prefix.
   d. Select compression or encryption as appropriate for your environment.
   e. Click Apply.

   Note: The encryption option only encrypts the transport of data between the FastBack server and the FastBack hub server. At the replication site, data is stored unencrypted. So, no encryption key is needed to restore clients in the disaster recovery site.

3. Run a test by selecting Test configuration. Click Yes when told the test only uses the applied values. If the test completes successfully, you receive a message, as shown in Figure 4-45. If the test does not run successfully, verify the corresponding parameters. You can first test using a simple FTP action from the FastBack server to the hub server to verify the FTP action.

4. After you test the configuration successfully, save it using the icon in the lower right part of FastBack Server window.
5. You can now test running snapshots to the FastBack restore server with the **Run now** button. You can check the status and progress of the process by moving the mouse over the icon on the bottom right as shown in Figure 4-46.

![Figure 4-46   FastBack disaster recovery status during replication](image)

### 4.6.4 Configuring Central Control Station

In our environment, we installed Central Control Station, FastBack Manager, and FastBack Mount with FastBack Hub Server in one step. The Central Control Station is the GUI that a disaster recovery location administrator can use to control replication processes. To configure Central Control Station, follow these steps:

1. Start the Central Control Station using **Programs → Tivoli Storage Manager → FastBack → Central Control Station**.

2. The connection panel (Figure 4-47) allows you to connect to the hub server. You must enter the Shared Snapshots Path. This entry points to the Logs directory that you created as in Figure 4-41 on page 87.

![Figure 4-47   Connecting to the hub server](image)
3. If you already ran a replication after you configured the hub server connection in 4.6.3, “Configuring FastBack Server Disaster Recovery” on page 90, you can see the status information about the Central Control Station, as shown in Figure 4-48.
When right-clicking the server icon under FastBack Servers in Central Control Station, you can start FastBack Manager directly from this window. However, in our installation, Central Control Station at Version V5.5.0.00138 was in error, as shown in Figure 4-49. APAR is under work.

Figure 4-49 Error starting FastBack Manager from within Central Control Station

4.7 Preparing Tivoli Storage Manager FastBack for Bare Machine Recovery

To be able to perform Bare Machine Recovery, you have to prepare a boot CD. You might need to prepare different CD images for each type of machine with different types of network interface card (NIC) or disk drivers. This section provides simple step-by-step instructions for creating a Bare Machine Recovery CD. We discuss the following:

- Creating a Bare Machine Recovery CD
- Creating a customized Bare Machine Recovery CD

4.7.1 Creating a Bare Machine Recovery CD

To create the Bare Machine Recovery CD, you need to complete the following tasks:

1. Installing Windows Automated Installation Kit
2. Creating a work folder
3. Downloading software packages
4. Creating the Bare Machine Recovery CD
5. Testing the CD
Installing Windows Automated Installation Kit
The Bare Machine Recovery CD uses Microsoft Windows Preinstallation Environment (WinPE), which is included in the Windows Automated Installation Kit (AIK). You can download the Microsoft Windows Automated Installation Kit from the following Microsoft Web site:


After you download the kit, create a DVD from the image using your DVD burning software. The image is a Windows Image File (.IMG) format. Use the DVD to install Windows Automated Installation Kit as follows:

1. Run the installation from the DVD. In the installation window, select Windows AIK Setup, as shown in Figure 4-50.

![Installer window](image)

Figure 4-50 Installer window
2. Click **Next** in the Welcome window, as shown in Figure 4-51.

![Welcome window for the Windows AIK installer](image)

*Figure 4-51  Welcome window for the Windows AIK installer*
3. The License Agreement displays. Read the agreement and click I **Agree** and then **Next**, as shown in Figure 4-52. Otherwise, click I **Do Not Agree**.

*Figure 4-52  License Agreement dialog box for the Windows AIK installer*
4. Select an installation folder for the Windows Automated Installation Kit. This path is used later to create the BMR CD. For our testing, we used the default path of C:\Program Files\Windows AIK\ (as shown in Figure 4-53). Click **Next**.

![Windows Automated Installation Kit](image)

**Figure 4-53  Windows AIK installation folder**
5. Click **Next** on the Confirm Installation window, as shown in Figure 4-54.

![Confirm Installation](image)

*Figure 4-54  Confirm Installation*
6. Click **Close** on the Installation Complete window, as shown in Figure 4-55. Windows Automated Installation Kit is now installed.

![Installation Complete](image1)

*Figure 4-55  Installation complete*

**Creating a work folder**

Create a work folder on a local disk. You use the work folder to create the bootable CD image so that you can add drivers and tools to the Bare Machine Recovery CD. We use the path C:\FastBackBMR. See Figure 4-56.

![Work folder](image2)

*Figure 4-56  Work folder*
**Downloading software packages**
To build the FastBack for Bare Machine Recovery CD, download TestDisk and Lister as described in this section.

**Downloading and installing TestDisk**
Download the latest version of the TestDisk from:

http://www.cgsecurity.org/wiki/TestDisk_Download

Decompress the file to your work folder (C:\FastBackBMR), and rename the extracted folder to TestDisk as shown in Figure 4-57

![Figure 4-57  Work folder with TestDisk](image-url)
**Downloading and installing Lister**

Download the latest version of the Lister file viewer from:

http://www.ghisler.com/lister/

Create a folder called *Lister* in the work folder (C:\FastBackBMR), and decompress the file as shown in Figure 4-58,

![Figure 4-58 Work folder with Lister](image)

**Creating the Bare Machine Recovery CD**

Now, you can create the Bare Machine Recovery CD. Insert the FastBack Bare Machine Recovery product installation CD into your CD-ROM drive and then complete the following steps:

1. Open a command line window and run the script
   `BuildTSMFastBackBMRCD.bat` that is located on the CD-ROM in the Installation folder.

2. Enter the path to the Windows Automated Installation Kit installation folder.
3. Enter the path of the work folder (C:\FastBackBMR).
4. Enter the drive letter of the FastBack Bare Machine Recovery installation CD.
5. Enter the installation language.

Example 4-1 shows this series of commands.

*Example 4-1  Creating the CD image*

```
D:\Installation> BuildTSMFastBackBMRCD.bat
IBM Tivoli Storage Manager FastBack Bare Machine Recovery
Bare Machine Recovery CD generation script
(c) Copyright by IBM Corporation and other(s) 1990, 2008. All Rights Reserved.
```
Enter the path without quotation marks to the Microsoft AIK installation folder [C:\Program Files\Windows AIK]
C:\Program Files\Windows AIK

Enter the path without quotation marks to work area folder [C:\FastBackBMR]
C:\FastBackBMR

Enter the drive letter of the FastBack installation CD [D:] : D:

Enter the installation language [EN-US] : EN-US

The creation process begins. After a few minutes, the script creates an ISO file in the Output directory of the Work folder, as shown in Figure 4-59.

![Figure 4-59: Output folder with our BMR CD created](image)

Burn the winpe_x86.iso file to a CD.
Testing the CD
We tested the CD on a VMware workstation environment. We created a new virtual machine in VMware Workstation with the settings shown in Figure 4-60.

As shown in Figure 4-60, we used the previously created ISO file as the CD-ROM drive.

To test the CD:

1. Start the virtual machine. You might need to change the appropriate settings in VMware BIOS setup configuration utility. Press Esc when the VMware machine is starting, and select CD-ROM in the Boot Menu as shown in Figure 4-61.
2. The virtual machine boots from the Bare Machine Recovery CD. You have to click **Accept** in the License Agreement as shown in Figure 4-62.

![License Agreement](image)

**Figure 4-62  License Agreement**

In our environment, the Bare Machine Recovery CD cannot locate the VMware Network Driver and displays an error as shown in Figure 4-63.

![Error Message](image)

**Figure 4-63  No adapter selected error**
Thus, our Bare Machine Recovery CD does not have the appropriate network drivers to work in the VMware environment because Windows PE does not support VMware network drivers. We have to add these drivers, and create a customized recovery CD image, as discussed in the next section.

### 4.7.2 Creating a customized Bare Machine Recovery CD

Before you create a customized CD, you must download and copy drivers to the Work folder to be included in the Bare Machine Recovery CD. You can customize your FastBack Bare Machine Recovery CD with the following drivers:

- **Network drivers**: The Bare Machine Recovery CD uses these driver to set up a network configuration and to communicate with the FastBack server to restore a snapshot or volume in case of disaster.
- **Disk or SCSI drivers**: The Bare Machine Recovery CD uses these drivers to have access to the hard disk and to perform a restoration.
- **Other hardware drivers**: The Bare Machine Recovery CD uses these drivers to boot in a dissimilar hardware and to restore the server.

Consult the following Tivoli Storage Manager FastBack Web page for instructions how to obtain device drivers to be used for Bare Machine Recovery:

http://www-01.ibm.com/support/docview.wss?rs=3509&context=SS9NXZ&q1=1316096&uid=swg21316096

We downloaded the drivers listed in Table 4-1 and copied them to the temporary Work folder.

#### Table 4-1 VMware drivers and destination folders

<table>
<thead>
<tr>
<th>Driver</th>
<th>Destination Folder</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMware LSI Logic SCSI Driver</td>
<td>C:\FastBackBMR\DissimilarStorageDrivers\lsi_w2k_w2k3</td>
</tr>
<tr>
<td>VMSCSI BusLogic XP/2003</td>
<td>C:\FastBackBMR\PEDrivers\StorageDrivers\vmsci</td>
</tr>
<tr>
<td>VMxnet Network Adapter</td>
<td>C:\FastBackBMR\PEDrivers\NetworkDrivers\vmxnet\win2k</td>
</tr>
</tbody>
</table>
We used our previous Work folder, which has additional VMware drivers as shown in Figure 4-64.

Figure 4-64  Work folder with VMware drivers

Repeat the process described in “Creating the Bare Machine Recovery CD” on page 102 to create a new Bare Machine Recovery CD, and the ISO file will now include the VMware drivers needed.
With the new ISO file, start the VMWare machine, VMBMRTEST. The Bare Machine Recovery CD boots, and the VMWare Network Adapter is available. You can configure the network connection to communicate with the FastBack server. In this scenario, we configure the IP properties as shown in Figure 4-65.

![Network adapter and properties in FastBack Bare Machine Recovery](image)

**Note:** To perform Bare Machine Recovery in a damaged server, you must test the Bare Machine Recovery CD before the disaster so that you can customize the CD with appropriate drivers if necessary. You can also verify its capability to restore to a different hardware configuration.

For more information about using Bare Machine Recovery, see *Tivoli Storage Manager FastBack for Bare Machine Recovery User's Guide*, SC26-2308.
With all the elements of IBM Tivoli Storage Manager FastBack installed, in this chapter we provide some basic usage scenarios. This chapter includes the following topics:

- 5.1, “Demonstration overview” on page 110
- 5.2, “Working with a repository” on page 112
- 5.3, “Basic configuration for client backup” on page 116
- 5.4, “Data recovery” on page 126
- 5.5, “Continuous Data Protection” on page 136
- 5.6, “Microsoft Exchange server protection” on page 141
- 5.7, “Backing up and restoring a Microsoft SQL Server database” on page 153
- 5.8, “Performing a Bare Machine Recovery” on page 161
5.1 Demonstration overview

This chapter describes some scenarios that you can use with Tivoli Storage Manager FastBack. We discuss how to back up and, more importantly, to recover files, volumes, and other objects using Tivoli Storage Manager FastBack.

5.1.1 Usage scenarios

We discuss the following usage scenarios in this chapter:

- Storing Tivoli Storage Manager FastBack snapshots within the Tivoli Storage Manager FastBack repository. We discuss this scenario in 5.2, “Working with a repository” on page 112.

- After the repository is defined, snapshot operation can be performed. In 5.3, “Basic configuration for client backup” on page 116, we explain the basic configuration to start performing backup (snapshot) operation.

- We discuss volume and individual file recovery from the repository in 5.4, “Data recovery” on page 126, which is the main consideration for using Tivoli Storage Manager FastBack.

- For critical servers, you might want to perform Continuous Data Protection (CDP). CDP allows you to pass data changes to the repository, thus allowing the whole volume to be recovered to almost any point in time. We discuss this scenario in 5.5, “Continuous Data Protection” on page 136.

- Application support is critical to ensure that the backup is performed correctly. Tivoli Storage Manager FastBack provides a unique capability to recover specific objects from the Microsoft Exchange server, as we discuss in 5.6, “Microsoft Exchange server protection” on page 141.

- Tivoli Storage Manager FastBack supports database backup with Microsoft SQL Server, based on Volume Shadow-copy Services. We explain this scenario in 5.7, “Backing up and restoring a Microsoft SQL Server database” on page 153.

- Recovering the operating system partition from a pristine machine is discussed in 5.8, “Performing a Bare Machine Recovery” on page 161, including converting the Windows image support from one hardware to another.
5.1.2 Environment setting

Figure 5-1 shows the servers and roles in our test environment.

To provide accurate testing and to simulate real users on the system, the file servers are loaded with a random file generator. It simulated the following conditions:

- Created files between 10 KB and 1 MB in size
- Generated 20 directories
- Created 50 to 100 text files per directory
- Updated, deleted, or created a file every 20 seconds

This program provides a realistic dynamic environment for Tivoli Storage Manager FastBack that can explore the operation of different types of backup snapshots taken with changing data. For more information about this utility, see Appendix B, “REXX utility for simulating file server operation” on page 209.

The Microsoft Exchange server in our environment is also populated with users that are typically found at a branch office. Meetings and e-mail are scheduled to provide content and to allow item level recovery during testing.
5.2 Working with a repository

Tivoli Storage Manager FastBack server uses a disk area for storing a client’s snapshots. This area is called the repository. The repository can be a folder, a physical disk, a SAN, or NAS drive. Tivoli Storage Manager FastBack must have at least one repository defined before configuration can occur, and the server is in limited access mode until a repository is defined.

This section discusses repository configuration.

5.2.1 Configuring the initial repository

To configure the initial repository, follow these steps:

1. Start Tivoli Storage Manager FastBack Manager by selecting Programs → Tivoli Storage Manager → FastBack → FastBack Manager. Log on to Tivoli Storage Manager FastBack Manager using the default user name admin and password admin123, as shown in Figure 5-2.

```
Figure 5-2   Login box
```


2. The first time that you log on, you need to define a repository using the wizard shown in Figure 5-3. Only disks that do not have data can be used as a repository.

![Repository wizard](image)

Select a repository and click **Apply**. FastBack Manager restarts to use the new repository.

You can now log in to FastBack Manager again. Tivoli Storage Manager FastBack is now ready to be configured. Make any necessary changes to antivirus tools to exclude the repository disks from any scans.
5.2.2 Defining a repository

You can define an additional repository after the initial configuration from the local disk or from networked storage (SAN or NAS). (To adding a local disk, see also “New storage attached to the FastBack Server is read only” on page 181.)

To define a repository, follow these steps:

1. In the Tivoli Storage FastBack window, select the Configuration tab, and then select General Configuration → Storage Pool as shown in Figure 5-4.

![storage_pool_diagram]
2. At the bottom of the window that displays, select the disk that you want to add as a repository. Remember that the disk must be empty. Then, right-click the required disk, and select **Add to repository**, as shown in Figure 5-5.

![Figure 5-5 Adding a repository](image)

3. Tivoli Storage Manager FastBack Server restarts as shown in Figure 5-6. Click **OK** to confirm.

![Figure 5-6 Restart of Tivoli Storage Manager FastBack Server](image)
5.3 Basic configuration for client backup

To get the Tivoli Storage Manager FastBack Server working, you need to configure the client group, schedule, and policy.

► Client groups
  Specify the group of volumes that are backed up. In addition to volumes, client groups can also include SQL and Microsoft Exchange databases for backup, even if they span across multiple disk volumes.

► Schedules
  Determine the type of snapshots and when the snapshots are performed.

► Policies
  Link client groups to a job schedule, specify the number of snapshots that are retained, and identify the snapshot priority.

This section explains this configuration procedure, which must be performed after Tivoli Storage Manager FastBack Client is connected to the server.

**Note:** In this section, we define the client groups and schedules separately from the policy definition. It is possible to define all these items from the policy definition process. However, we recommend to define them separately to ensure good planning for client groups and schedules.
5.3.1 Defining a client group

To define a client group, follow these steps:

1. Open the Tivoli Storage Manager FastBack Manager, and select the Configuration tab.

2. Right-click Client groups and select New Client Group as shown in Figure 5-7.

Figure 5-7  Select New Client group
3. In the dialog box that displays, Figure 5-8, perform the following tasks:
   a. Enter the Client Group name.
   b. Expand the **Storage** → **client** → **drive** hierarchy, and select the volume that you want to include.
   c. Optionally, clear the drive where Windows is installed (typically C:\)
   d. Click **Apply**.

![Figure 5-8   Defining a client group](image-url)
5.3.2 Defining a schedule

Schedules are defined similarly to client groups. To define a schedule:

1. Right-click **Job Schedules** and select **New Job Schedule**, as shown in Figure 5-9.
2. A new Job Schedule window opens, similar to that shown in Figure 5-10. In this window:
   a. Enter a Job Schedule Name.
   b. Select job type incremental forever.
   c. Define the time or interval to perform a snapshot.
   d. Select the days of the week to run. The default is a standard working week.
   e. Click **Accept**.

   ![Job Schedule Window](image)

   **Figure 5-10** Define schedules
5.3.3 Defining a policy

After the client group and schedule are defined, you can work with policies. Follow these steps:

1. Right-click **Policy** and select **New Policies**, as shown in Figure 5-11.
2. In the “Use an existing Client Group” tab, select the client group that you want to add to the policy, and click Add, as shown in Figure 5-12. Click Next.

**Figure 5-12  Select client group for the policy**
3. In the “Use an existing Job Schedule” tab, select the schedule that you want to add to the policy, and click **Add**, as shown in Figure 5-13. Click **Next**.

**Figure 5-13  Select schedule for the policy**
4. In the Summary tab, Figure 5-14, select the Number of Generations to keep. In this case, we specify 10. The default is 24 generations.

5. Select **Finish**.
5.3.4 Testing the policy

After you have defined a policy to the FastBack Server, you can run it outside of the scheduled backup to test the client and server configurations. To test the policy, right-click the policy, and select **Run Full Snapshot™**, as shown in Figure 5-15.

![Figure 5-15  Running full snapshot](image)
A job is then placed in the Snapshots Monitor of Tivoli Storage Manager FastBack. Verify that the job completed, as shown in Figure 5-16.

![Figure 5-16   Snapshot monitor](image)

### 5.4 Data recovery

With the snapshots taken in 5.3, “Basic configuration for client backup” on page 116, we now want to demonstrate recovery. You can recover the data that was backed up. FastBack allows you to restore volume level data from the FastBack Server or an individual file using FastBack Mount. Provided that you have the authority to access the file, you can restore into the same disk or any disk on any computer that is connected to the snapshot.

In this section, we provide examples of volume, file, and hub server recovery.
5.4.1 Volume recovery

This procedure performs volume recovery:

1. Log in to FastBack Manager, and select the Recovery tab, as shown in Figure 5-17.

![Figure 5-17 Recovery tab](image)

2. the Volume-level Restore as shown in Figure 5-18.

![Figure 5-18 Volume-level Restore](image)
3. Select the snapshot to be recovered to by clicking it, as shown in Figure 5-19.

4. Select the target location to which to restore the snapshot. This target can be the original volume or another volume on another server. See Figure 5-20. Click Apply.
5. Click **Yes** to accept the operation, as shown in Figure 5-21.

![Figure 5-21 Accept the restoration](image)

6. Finally, click **Yes** to confirm, as shown in Figure 5-22.

![Figure 5-22 Confirm the restoration](image)

### 5.4.2 File recovery

Using FastBack Mount, you can mount the snapshots as physical disks. You can mount a snapshot to which you have access on any machine that is connected to the repository. The mounted snapshot acts just like a Windows drive. You can use a simple Windows file operation to move the file or files around.

FastBack Mount is loaded as part of the FastBack Client and FastBack Server installations. It resides as an icon in the system tray, as shown in Figure 5-23.

![Figure 5-23 FastBack Mount installed](image)
To begin file recovery:

1. Launch FastBack Mount by clicking the icon in the system tray. The FastBack Mount window opens, as shown in Figure 5-24. Select the repository from the drop-down menu.

![FastBack Mount Window](image)

*Figure 5-24  FastBack Mount*
2. You need to go select the folder where the FastBack repository is located. See Figure 5-25. Click **Browse**.

![Folder Browser](image)

*Figure 5-25  Browse to folder*

3. Select the folder or drive where the FastBack repository is located, as shown in Figure 5-26. Then, click **OK**.

![Browse for folder](image)

*Figure 5-26  Select drive or folder*
4. Next, enter the user ID and password that has access rights to the repository in the form `DOMAIN\user`. This credential is used by FastBack Mount to connect to the disk. FastBack Mount runs as a service with the LocalSystem authority. It needs explicit access credentials to connect to a network drive. See Figure 5-27.

![Folder Browser](image.png)

**Figure 5-27 User ID and password**
The dialog box is populated automatically with snapshot information, as shown in Figure 5-28.

You can then select snapshots by the following criteria:

- Policy
- Server
- Volume
- Date and time
5. After you select a snapshot, select **Mount** to access the mount point dialog box as shown in Figure 5-29. Select a drive letter, or mount the snapshot in an empty folder. Then, click **OK**.

![Choose mount destination dialog](image)

**Figure 5-29  Mount destination**

The mounted snapshot is indicated in the FastBack Mount dialog box along with policy and computer name as shown in Figure 5-30.

![Mounted Volumes dialog](image)

**Figure 5-30  Mounted Volumes**

You can now access the mounted drive (F:) as a normal drive. You can access the drive using Windows Explorer so that backup administrators can copy and paste the files that are needed for recovery.

### 5.4.3 Hub server recovery

You can perform file recovery from the hub server using methods similar to the file recovery from the local FastBack server, as discussed in 5.4.2, “File recovery” on page 129. You define a share from the FastBack hub server and access it through FastBack Mount interface.
We found in our testing that the repository might be is in a locked state when the replication is performed. If this situation occurs, you get a FBSM8014E message, as shown in Figure 5-31.

Figure 5-31   Repository locked

This error might be due to an excessive schedule for performing the FTP process. If there are still FTP processes that are active, the mount will fail.
5.5 Continuous Data Protection

FastBack allows backup administrators to match the backup policies to business needs for recovery point objectives (RPO) and recovery time objectives (RTO). Normal snapshots record backup data at a certain point in time.

Continuous Data Protection (CDP) records all activity that takes place between snapshots. If enabled, Continuous Data Protection allows data restoration to any specific point in time after the last snapshot and between the last snapshot and the previous snapshot on the same chain with a precision of up to a single second.

When the backup requirement enforces RPO within minutes and an RTO of an hour or less, then Continuous Data Protection provides the best solution.

**Note:** Continuous Data Protection monitors disk updates, therefore:

- Using Continuous Data Protection requires additional processor, memory, and network bandwidth resources.
- Running defragmentation on volumes protected Continuous Data Protection generates a significant load on the server running Continuous Data Protection, in addition to large incremental snapshots, and might result in failure.
- It is not recommended to run Continuous Data Protection on volumes where page files or the operating system files are installed.
5.5.1 Configuring Continuous Data Protection

The process of setting up Continuous Data Protection is on the schedule. In the schedule definition, you activate Continuous Data Protection by selecting Enable CDP, as shown in Figure 5-32.

![Figure 5-32 Define schedules](image)

After you enable Continuous Data Protection, confirm that the Snapshots Monitor is operating correctly. Table 5-1 shows the icons linked with Continuous Data Protection.

<table>
<thead>
<tr>
<th>Icons</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Continuous Data Protection Snapshot is running.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Continuous Data Protection Snapshot, completed successfully.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Incomplete Continuous Data Protection snapshot. The Continuous Data Protection data before the abort point might be available.</td>
</tr>
</tbody>
</table>

**Note:** If a time of other than 1 hour is used, we recommend using a 1 hour time period.
5.5.2 Restoring Continuous Data Protection snapshot

To restore a Continuous Data Protection snapshot, complete the following steps:

1. Click **Snapshot Monitor**.
2. Right-click a Continuous Data Protection snapshot, and select **Restore → CDP Volume Restore** as shown in Figure 5-33.

![Figure 5-33 CDP volume restoration](image)

Only the last two Continuous Data Protection snapshots from each chain are available in the Snapshot Monitor list.
3. In the window that opens, select a destination volume and click **Next Step**. See Figure 5-34.

**Note:** Close any applications that are holding open handles on the destination volume. The restoration operation fails if there are open handles on the target restoration volume. These open handles include any open files or applications that are currently running on the destination volume. If you select **Ignore open handles on the destination volume**, Tivoli Storage Manager FastBack ignores open handles on the destination volume, which can cause issues with applications and loss of data in files that are open on the target volume.

![Figure 5-34 Destination volume](image)
The window that opens, shown in Figure 5-35, contains a scale that represents the time between two snapshots for the Continuous Data Protection range. In this scale:

- Events that took place during that time are green lines.
- Consistency points within that range are blue.
- Hovering over an event or a consistency point shows a tool tip that indicates the event and consistency point name.
- Parts of the Continuous Data Protection range that are marked with a broken red line are periods within the Continuous Data Protection range in which no activity was registered because the server was not available because of network issues. These periods cannot be restored using the Continuous Data Protection feature. To restore the data covered by the red broken line, use the next consistent snapshot.

4. Move the sliding dial to the point where you want to restore.

- The time and date are indicated in the time and date fields below the time line. You can also enter the desired time in the time field. If the time field contains the valid Continuous Data Protection restoration time, its font color is black. Otherwise it is red. The date field is disabled and can be changed only by moving the dial when the scale’s range exceeds one day.
- If you select Restore to consistency points or events only, the dial always snaps to the closest event or consistency point, allowing restoration of only consistency points or events.

5. Click Restore. The point you selected is restored to the destination volume that you specified in Figure 5-34. Restore is enabled only when a valid restoration time is selected.
5.6 Microsoft Exchange server protection

Tivoli Storage Manager FastBack provides point-in-time copies of Microsoft Exchange databases and transaction logs, without compromising either data integrity or performance of online operations.

Tivoli Storage Manager FastBack for Microsoft Exchange detects the version of Microsoft Exchange that is installed on the server and the configured storage groups automatically. If you have several different versions of Microsoft Exchange, create a different policy for each version. Snapshots are taken of each selected Storage Group as a whole. Each snapshot consists of the *.EDB, *.LOG, *.CHK and *.STM (Exchange 2000/2003 only) for each Storage Group.

There are three possible scenarios for Microsoft Exchange backup:

► Quiescent

Results in fully a consistent database with excellent chances for restoration. It requires interrupting the server’s operation. The application is released immediately, while the backup process happens. During the “offline backup,” Microsoft Exchange services are temporarily shut down to bring Exchange databases to a consistent state.

► Non-quiescent

Performed without interrupting the server’s operation and therefore can be executed more often. However, it might lead to non-consistent databases with a longer restoration process and can result in data loss.

► Volume Shadow Copy Service (VSS)

Creates consistent point-in-time copies of selected data/volumes by creating a database of modified data files in the shadow copy service. Tivoli Storage Manager FastBack fully supports the use of Volume Shadow Copy Service on Windows Server® 2003 and higher.

Appendix A, “Volume Shadow Copy Service” on page 205 provides more detail about configuration of FastBack and VSS.

**Note:** It is recommended that you disable the circular logging option and delete unnecessary log files using the Purge Log option in FastBack Manager. After the backup is completed, log files can be erased automatically from primary storage. You can set this option after the snapshot is complete using the **General category → Application** tab. You can modify settings per job at a Job schedule level.
FastBack for Microsoft Exchange is a powerful tool that goes beyond the volume level recovery. It provides an interface to allow the recovery of individual mailboxes and items within users' mailboxes such as:

- E-mail messages
- Folders
- Calendar items
- Private folders
- Mail attachments

The interface provides backup administrators the capability to save the restored mailbox content in different ways:

- Direct exchange restoration where a source (a snapshot of a Microsoft Exchange database) and target are used. FastBack for Microsoft Exchange allows items to be copied back to a user's mailbox.

- SMTP restoration where recovered e-mail messages are sent to users over an internal network or the Internet.

- Save individual items and e-mail attachments to local disk or user home drives for quick access.

FastBack for Microsoft Exchange has an effective search capability, allowing an administrator to search against specific criteria rather than searching through each individual mailbox and items in the mailbox.
5.6.1 Configuring a Microsoft Exchange 2003 client

To configure the Microsoft Exchange 2003 client, you can follow the steps in 5.3, “Basic configuration for client backup” on page 116 with the following differences:

1. When you select the client volume, select the Microsoft Exchange 2003 database and storage groups, as shown in Figure 5-36.

![Figure 5-36  Exchange Storage Group](image)
2. When creating the schedule, as described in 5.3.2, “Defining a schedule” on page 119, select **Application Aware** to access the Application Aware window, as shown in Figure 5-37.

3. Select to preserve application consistency, and select **Use VSS application quiescing**. Click **OK**.

![Figure 5-37  Application Aware window](image)

4. Then, complete the configuration as described in 5.3.3, “Defining a policy” on page 121.

5.6.2 Direct restoration for Microsoft Exchange

For a direct restoration, FastBack exchange needs a source and a target:

- The source is a mounted snapshot with an accessible Microsoft Exchange database
- The target must be an Outlook profile, a user's mailbox, or a personal folder (PST file).
In this section, we describe how to use a mailbox as a target to recover an individual e-mail:

1. Log on to the FastBack for Microsoft Exchange server with Domain or Enterprise admin rights.
2. Mount a snapshot using FastBack Mount, as shown in Figure 5-38.

![Figure 5-38  Mount an exchange snapshot](image)
3. Select Programs → Tivoli Storage Manager → FastBack for Microsoft Exchange → FastBack for Microsoft Exchange to launch the application. See Figure 5-39.

![Figure 5-39  FastBack for Microsoft Exchange user interface](image)

4. In FastBack for Microsoft Exchange, select File → Open edb file, see Figure 5-40.

![Figure 5-40  Open mail database](image)
5. Select **Direct Exchange Restore → Open Mailbox**, as shown in Figure 5-41.
6. In the General tab, enter the Microsoft Exchange server name to which you want to restore the mailbox. Enter the mailbox name, and click **Check Name**. The Microsoft Exchange server confirms and underlines the server name and mailbox, as shown in Figure 5-42. Click **OK** to load the mailbox.

![Microsoft Exchange Server](image)

*Figure 5-42  Microsoft Exchange and mailbox access*
7. FastBack for Microsoft Exchange now has a source from the mounted snapshot. It has a target mailbox on the live Microsoft Exchange server. Right-click an item in the selected folder area, and select **Restore to Exchange**, as shown in Figure 5-43.

![Figure 5-43  Restore to Microsoft Exchange](image)
8. Select the target folder to which you want to copy the item on the target mailbox, and click **OK**, as shown in Figure 5-44.

![Select the target folder](image)

*Figure 5-44  Select target folder*

9. FastBack for Microsoft Exchange provides a progress bar and log information to a file if needed. After the item is copied successfully to the target, click **Close**, as shown in Figure 5-45.

![Copy Progress](image)

*Figure 5-45  Item Copy Progress*
The item is now copied into the mailbox, as shown in Figure 5-46. The process is valid for single items as well as folders, inboxes or complete mailboxes.

5.6.3 Restoring e-mail using SMTP

To access a Microsoft Exchange database from a mounted snapshot, follow steps 1 to 4 in 5.6.2, “Direct restoration for Microsoft Exchange” on page 144. FastBack for Microsoft Exchange allows recovery of an individual mail sent to a Simple Mail Transport Protocol (SMTP) server. Then, to restore the e-mail, follow these steps:

1. Right-click the e-mail, and then click **SMTP e-mail Restore**, as shown in Figure 5-47. You can also use SMTP to restore a folder of e-mail messages by right-clicking the folder.
2. In the SMTP Properties window, enter the following information:
   a. The host name or the IP address for the target SMTP server and the port number. This is typically port 25 for the SMTP protocol.
   b. The e-mail address for the sender (for example, administrator@xyz.com). The e-mail address is needed because some SMTP servers must have a valid sender e-mail address to authenticate the user and to accept the e-mail. The e-mail address for the sender is not identified as the source address for any of the e-mail messages.
   c. The e-mail address for the recipient (for example, user@xyz.com). Check with the mail administrator if you are unsure.

   Click OK.
5.6.4  Saving a Microsoft Exchange e-mail

To access a Microsoft Exchange database from a mounted snapshot, follow steps 1 to 4 in 5.6.2, “Direct restoration for Microsoft Exchange” on page 144. Then, to save an e-mail, follow these steps:

1. In the selected folder item detail area, right-click the e-mail that you want to save. See Figure 5-47 on page 151.

2. Click **Save e-mail**.

3. If the e-mail has an attachment select **Yes** to save it with the e-mail or select **No** to save just the e-mail.

4. Enter the location where the e-mail will be saved, and click **OK**. Any disk or network share location is valid.

5.7  Backing up and restoring a Microsoft SQL Server database

This section describes an example for backing up and restoring a Microsoft SQL Server database.

5.7.1  Configuring the backup for Microsoft SQL Server

Tivoli Storage Manager FastBack provides enhanced capabilities for backup and restoration of Microsoft SQL Server without compromising data integrity or performance of online operations. In this example, we use Microsoft SQL Server backup with the VSS option for a consistent backup of Microsoft SQL Server database and log files.

**Configuring the Microsoft SQL Server**

The Microsoft SQL Server database server must have FastBack Client installed. The database backup is performed at volume level similar to a regular volume backup.

Install the FastBack client in the SQL server and configure it to connect to the FastBack server as described in 4.3, “Installing Tivoli Storage Manager FastBack Client” on page 58.
Configuring FastBack Server

To perform a consistent backup of Microsoft SQL Server, follow these steps:

1. Create a Client Group with Microsoft SQL Server, as shown in Figure 5-49.

Figure 5-49 Client Group with Microsoft SQL Server
2. Create a Job Schedule. In this example, we create an hourly incremental forever job, as shown in Figure 5-50. Select **Application Aware**.

![Figure 5-50  Job schedules for SQL](image)

3. Ensure that **Preserve application consistency** and the use of **VSS application quiescing** is selected, as shown in Figure 5-51.

![Figure 5-51  Application Aware Options](image)
4. Create a Policy with the Client Group and the Job Schedule created previously, as shown in Figure 5-52.

![Policy with Incremental Forever Schedule and SQL client group](image)

*Figure 5-52 Policy with Incremental Forever Schedule and SQL client group*
The Job schedule takes first a full snapshot and then an incremental snapshot every hour, as shown in Figure 5-53.

Figure 5-53  Snapshot monitor filtered with SQL snapshots
5. Select one snapshot from the list. Then, right-click, and select **Events**. The Snapshot Events dialog box displays, as shown in Figure 5-54.

![Snapshot Events dialog box](image)

*Figure 5-54  Snapshot Events dialog box*

Now you have consistent snapshots of the Microsoft SQL Server that is stored in the FastBack server.
5.7.2 Restoring a Microsoft SQL Server database

In this example, we restore a Microsoft SQL Server:

1. In the SQL server, open FastBack Mount, and mount the snapshot that you want to restore, as shown in Figure 5-55.

![FastBack Mount](image)
2. Locate the database files in the drive and copy the data and log files to a hard disk in the SQL server, as shown in Figure 5-56.

![Folder with data and log files](image)

**Figure 5-56  Folder with data and log files**

**Note:** If you are trying to attach directly from a FastBack Mount volume, you must perform the following tasks:

- Make sure that the volume is mounted as read/write.
- When you attach to the volume using the SQL Enterprise Manager, give it a different name (under the attach as). You do not need to rename the files; just rename the logical database name.

In this example, we use the database *AdventureWorks*, which is an example database that is included with Microsoft SQL Server.
3. Open SQL Server Management Studio, and connect to the SQL server. Then, right-click the select Databases folder icon and select Attach to locate the database files as shown in Figure 5-57.

![Figure 5-57  Attach databases in SQL server](image)

5.8 Performing a Bare Machine Recovery

This section describes how to perform Bare Machine Recovery. The information in this section assumes that the FastBack server and client are configured correctly and that full backup snapshots of the operating system partition are captured on the server’s repository. Also, make sure that you have built and customized the Bare Machine Recovery CD. Refer to 4.7, “Preparing Tivoli Storage Manager FastBack for Bare Machine Recovery” on page 94 for more information.
5.8.1 Example of a common Bare Machine Recovery scenario

A common Bare Machine Recovery scenario is to restore a physical server to a virtual or a temporary server while the physical server is replaced or repaired. In our test environment, we had a physical server, named *CUENCA*, with the following configuration:

- Operative system: Windows 2003 Server
- RAM: 1 Gb
- Processor: 2 Intel CPUs
- Hard disk: 1 SCSI HD, 16 Gb

First, perform a full snapshot of the server CUENCA as shown in Figure 5-58.

![Figure 5-58 Snapshot monitor with CUENCA](image)

Then, to perform a restoration of CUENCA, we use the previous VMware machine that we created to test the Bare Machine Recovery CD as follows:

1. Boot the virtual machine from the customized Bare Machine Recovery CD with VMware Drivers. When the License Agreement displays, read it and click *Accept*.
2. Configure the appropriate IP address to communicate with the FastBack server. In our testing, we used DHCP. Then, click *Next*.
3. Enter the appropriate Domain, Username, and Password to access the FastBack Server Repository Share, as shown in Figure 5-59. Authentication is required. Then, enter the path to the FastBack Share repository. Usually, the path is \<FastBack Server>\FB_REP_XXX (for example, \9.3.5.161\FB_REP_E), where <FastBack Server> is the host name or IP address for the server, and XXX is the repository name.

![Remote FastBack repository security credentials](Image)

Figure 5-59  Remote FastBack repository security credentials
4. Select the snapshot that you want to restore. You can browse the current policies in your FastBack Server and choose the appropriate server, volume, and the snapshot that you want to restore. After you select the server, click Add Snapshot, and then click Restore. Refer to Figure 5-60.

Figure 5-60  Bare Machine snapshot restoration
5. In the Bare Machine Restore Confirmation dialog box, click **Yes** as shown in Figure 5-61.

![Bare Machine Restore Confirmation](image)

*Figure 5-61  Bare Machine Restore Confirmation*
6. Next, select the destination disk. You can change the destination disk if necessary. Then, click **Start disk restore** as shown in Figure 5-62.

![Bare Machine Recovery destination disk](image)

**Figure 5-62** Bare Machine Recovery destination disk

You can monitor the restoration progress in the Bare Machine Restore window as shown in Figure 5-63.

![Bare Machine Restore progress](image)

**Figure 5-63** Bare Machine Restore progress
Wait until the restoration process completes and you receive a message as shown in Figure 5-64.

![Figure 5-64 Bare Machine Recovery Complete](image)

In our testing environment, after the restoration completed and we booted the newly restored disk, we received a blue screen error as shown in Figure 5-65.

![Figure 5-65 Blue screen error](image)

A problem has been detected and Windows has been shut down to prevent damage to your computer.

If this is the first time you've seen this Stop error screen, restart your computer. If this screen appears again, follow these steps:

Check for viruses on your computer. Remove any newly installed hard drives or hard drive controllers. Check your hard drive to make sure it is properly configured and terminated. Run CHKDSK /F to check for hard drive corruption, and then restart your computer.

Technical information:

*** STOP: 0x0000007E (0x789E640,0xC0000034,0x00000000,0x00000000)
In our environment this issue was caused by the difference between the hardware configuration of our physical server and our VMware server. We fixed the issue using the Any-to-Any Hardware Restore tool that is included in the Bare Machine Recovery CD. You can fix Windows to boot properly with the following steps:

1. Boot the virtual server from the Bare Machine Recovery CD again. After you read the License Agreement, click **Accept**. Then, press **Next** in the Network Adapter Configuration window.

2. Click **Any to Any HW Restore** to open the tool.

3. The Any to Any HW Restore tool performs the following steps to fix the Windows installation to boot properly in a dissimilar hardware scenario (see Figure 5-67 on page 169):
c. **Verify Installation/Backup Registry**: Creates a backup of the current Windows registry.

d. **Install Drivers**: Copies drivers from the Bare Machine Recovery CD to the Windows server.

e. **Optional Settings**: Allows you to perform various configurations, to disable services, to configure HAL settings, to activate Sysprep, and so on.

4. Next, install the VMware SCSI disk driver, by clicking **Install driver** (Figure 5-67).

*Figure 5-67  Any to Any install drivers Step*
5. Our physical server had two CPUs and the VMware-based server had only one CPU. Thus, we changed the HAL setting by clicking **HAL Settings** (Figure 5-67). In the HAL Settings dialog box, select the ACPI Uniprocessor PC, and click **Install HAL** as shown in Figure 5-68.

![HAL Settings](image)

**Figure 5-68** Any to Any HAL Settings

6. Click **Finish**. Then, restart the VMware server, and Windows 2003 now boots normally.
Chapter 6. Best practices and troubleshooting tips

This chapter contains a collection of best practices, hints, and tips that we discovered during our testing and in the various documentation that we consulted during the writing of this book. The order of the information in this chapter has no relation to the value of the respective items and is not intended to be complete.

This chapter includes the following topics:

- 6.1, “Troubleshooting information” on page 172
- 6.2, “Miscellaneous hints and tips” on page 176
- 6.3, “Tivoli Storage Manager integration” on page 192
6.1 Troubleshooting information

To perform an initial troubleshooting for IBM Tivoli Storage Manager FastBack, you must collect information from the error symptom. List the symptoms that you believe are caused by the problem. Ask the following questions:

- Has this problem occurred before in your environment?
- When did you first notice the problem?
- Have there been any changes in your environment recently?

Because FastBack runs as Windows services, you must provide Windows system information. You can locate this information by going to Programs → Accessories → System Tools → System Information. Or, you can run c:\Program Files\Common Files\Microsoft Shared\MSInfo\misinfo32.exe. Inside the System Information Tool, select to File → Save, and the information is saved as System_Info.nfo.

FastBack errors can be collected from several different sources:

- Application and Server Event Logs
  Select to Control Panel → Administrative Tools → Event Viewer. You can save both the System and the Application log. Select Actions → Save Log File As and name the text files System Event Log.evt and Application Event Log.evt respectively.

- FastBack executable version information
  Provide the FastBack component and version number on which the errors occur, for example FastBack Mount Version 5.5.

- FastBack Logs and Files
  On the FastBack Client, go to following directory: C:\Documents and Settings\All Users\Application Data\Tivoli\TSM\Fastback\Client
  This folder contains error logs and configuration files for FastBack Client. Compress all files in this root directory (but do not include the other subdirectories) by highlighting the files, right-clicking, and then selecting Send To → Compressed Folder.

The components of Tivoli Storage Manager FastBack are standard windows services. The logs are stored under the Application Registry, and you can view the logs with the Microsoft Event Viewer.
6.1.1 FastBack Manager event log

In FastBack Manager, you can find the Events Log Level settings under **General Configuration** on the General tab. You can select the level of logs as shown in Figure 6-1.

![Figure 6-1 Events log level settings](image)
6.1.2 FastBack Server logs

In the FastBack Manager, you can see the logs for FastBack Server, as shown in Figure 6-2.

Figure 6-2  FastBack Server Log

6.1.3 FastBack Client and FastBack Mount logs

The event logs for FastBack Client and FastBack Mount are located in the Application view of Event Viewer, with all other applications logs.

In this example, we configure a new log view only with FastBack Client logs as follows:

1. Open the Event Viewer. Right-click Application, and select New Log View.
2. Rename the new Log view with FastBack Log.
4. Select the **Filter** tab, and select FastBack Client as the event source, as shown in Figure 6-3.

![Figure 6-3 Event Viewer](image)

5. Repeat these steps to create other views for the FastBack Mount event log.
6.1.4 FastBack Hub Server logs

FastBack Hub Server works with Microsoft FTP Service. It stores logs in the logs directory under the disaster recovery repository, as shown in Figure 6-4.

![FastBack Hub Server logs](image)

**Figure 6-4** Disaster recovery logs folder

6.2 Miscellaneous hints and tips

In this section, we list the hints and tips that we collected while writing this book. It includes the following topics:

- 6.2.1, “Installation and configuration considerations” on page 177
  - “FastBack Server clock” on page 177
  - “FastBack Client environment” on page 177
  - “FastBack Manager security” on page 178
  - “Running FastBack Bare Machine Recovery in VMware” on page 178
- 6.2.2, “Operational considerations” on page 179
  - “Uninstall Tivoli Storage Manager FastBack” on page 179
  - “Restoring network shares after Bare Machine Recovery for file servers” on page 180
  - “New storage attached to the FastBack Server is read only” on page 181
  - “FastBack Snapshot implications when client is rebooted” on page 182
  - “FastBack backup of database management system” on page 182
  - “Too much data during incremental snapshot” on page 183
  - “Maximum number of snapshots” on page 184
  - “Cleanup and replication cannot run simultaneously” on page 184
  - “FastBack and antivirus” on page 184
6.2.1 Installation and configuration considerations

This section includes considerations and recommendations for installation and configuration of Tivoli Storage Manager FastBack.

FastBack Server clock
Be sure to verify that the FastBack Server clock is set correctly because all backup and restoration operations are referenced according to this clock. Clock changes require resetting the FastBack Server. These changes includes automatic time synchronization of the Windows clock with the domain controller, change of time zone configuration, and daylight saving flag. For additional considerations see Chapter 6 of FastBack Installation and User's Guide, SC23-8562.

FastBack Client environment
Consider the following:
- Only snapshot of NTFS volumes can be used for file level restoration.
- Do not install the FastBack Client on the FastBack Server PC.
- FastBack does not support Bare Machine Recovery on Itanium. The environment FastBack Bare Machine Recovery boots into (WinPE) has significant limitations on Itanium hosts. Due to those current limitations, Bare Machine Recovery on Itanium hosts is not fully supported.
- After connecting a client to a server using Client Configurator, it is possible that you will not see the client in the client list (on FastBack Server). This could be due to a client version mismatch. The safest method to resolve this problem is to make sure that both the client and the server are using the exactly the same version of FastBack. After installing the correct version, restart both Client and Server services.
- Having two LAN cards on the same FastBack Client computer can result in identification and communication problems, which might prevent the FastBack
Server and FastBack Client from communicating properly. To solve this problem, make sure only one LAN card is registered in the DNS server, and remove the registry entries of all other LAN card of the same computer from the DNS server. For removal procedure refer to Chapter 32 of *FastBack Installation and User's Guide*, SC23-8562.

**FastBack Manager security**

FastBack Manager security considerations are:

- To use FastBack Manager, the user logged into the FastBack Manager machine must be a member of the Administrators User Group. Alternatively, the user must be given write permissions to the Program Files\Tivoli\TSM\FastBack\FastBack Manager folder.

- Different users can be logged-in simultaneously using different types of accounts, but a single user cannot combine permissions from Active Directory and FastBack Server accounts.

- Microsoft Active Directory (AD) users, FastBack Manager uses Active Directory groups are predefined groups of super users (administrators) with extensive system access privileges. FastBack Server allows you to use these groups as part of user login management. When you add an Active Directory group to the Active Directory group list in FastBack Manager, FastBack Manager recognizes members of this group during login and logs them in as administrators. After installation, the set of Microsoft Active Directory groups is empty. Adding/removing Active Directory groups to/from the MS Active Directory group list in FastBack Manager requires super-user access privileges; therefore, in order to configure Microsoft Active Directory groups, the first-time user must have FastBack superuser privileges. Non-admin users means all other users who are not members of an Active Directory group can only view the configuration options, monitor snapshots, and restoration volumes, folders, and files to which they have access permissions on the network.

**Running FastBack Bare Machine Recovery in VMware**

Some consideration for network devices:

- If you are using the vmxnet network adapter, you need to add its drivers to the Bare Machine Recovery CD as discussed in 4.7.2, “Creating a customized Bare Machine Recovery CD” on page 106.

- For the vlance and flexible network drivers, you can use the vmxnet installation.
If you are using E1000, the Intel Gigabit drivers are used, which are natively supported by our WinPE-based Bare Machine Recovery CD. You can force the VM to use E1000 even if this option is not available in GUI by editing the vmx file as follows:

a. Open the vmx file when the VM is down.

b. Add the following line just below the line ethernet0.present = "TRUE":
   
   \[ \text{ethernet0.virtualDev = "e1000"} \]

   c. Save the vmx file, and boot the VM.

6.2.2 Operational considerations

This section includes considerations and recommendations for operation of Tivoli Storage Manager FastBack.

Uninstall Tivoli Storage Manager FastBack

Uninstall Tivoli Storage Manager FastBack elements using the standard Uninstall button in the Control Panel, within Add or Remove Applications.

After you uninstall, you have to reboot and initialize the repository disk. (Without any FastBack components installed, it shows as an uninitialized disk in windows disk manager.)

The repository is a self sufficient entity, so it contains all the configuration files. During a following reinstallation of FastBack, the software identifies this as an existing repository that belongs to that server (same machine name, same domain) and forces you to work with that repository. Check also if the uninstall process leaves behind information in C:\Documents and Settings\All users\Application Data\tivoli\tsm\fastback and delete this information manually.

**Note:** If FastBack Server is given read/write access to any non-repository SAN disk, you must perform the following actions. Otherwise, your Windows operating system might be corrupted.

1. After uninstalling FastBack Server, before you reboot, disable access to this SAN disk from the FastBack Server using LUN masking or zoning.

2. Disconnect the system from the Fibre Channel.
Restoring network shares after Bare Machine Recovery for file servers

When following the recommended Bare Machine Recovery process (performing Bare Machine Recovery for the operating system volume and Instant Restore for the data volumes) for a file server, you need to re-create the network shares.

The issue is with the way that Microsoft Windows handles network shares. When the system boots after the Bare Machine Recovery process, the process looks for the actual physical folders in order to create the shares. Because the volumes are not present at this point, the system simply deletes them. All network shares information is retained in the registry under HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\lanmanserver\Shares

After the Instant Restore process begins and the physical volumes show in the network, re-create the shares, and the process for creating the shares is triggered. Uses these steps:

1. On the target machine, perform the Bare Machine Recovery, boot the machine, and start Instant Restore for the data volumes.

2. On the backup server:
   a. Mount the OS volume of the source machine. Make sure that you mount it in read/write mode (that is, clear the read only check box). Let us assume that it is mounted as G.
   b. Launch Regedit, and select "HKEY_LOCAL_MACHINE". From the File menu select Load hive.
   c. Browse to G:\Windows\System32\config, select the system file.
   d. Assign a name to the loaded hive. For this discussion, let us assume that we assign the name TemporaryHive.
   e. Browse to the following directory:
      HKEY_LOCAL_MACHINE\TemporaryHive\ControlSet003\Services\lanmanserver\Shares
      Right-click the shares key on the left pane, and select Export. Save the exported share keys to a file on the desktop called SharesInfo.reg.
   f. Use a text editor to open the file (SharesInfo.reg). Do not double-click the file. Then, in the file, perform a search and replace. Search for:
      HKEY_LOCAL_MACHINE\TemporaryHive\ControlSet003
      And change to:
      HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet
g. Save the file under a different name (for example, UpdatedSharesInfo.reg).

3. Copy UpdatedSharesInfo.reg to the target machine

4. On the target machine, double-click UpdatedSharesInfo.reg.

5. On the target machine, restart the “Server” service, which is the Windows service called Server, not the FastBack server.

**New storage attached to the FastBack Server is read only**

After the FastBack Server is installed, any new storage that you add to the FastBack Server machine is read only. Any write that goes to the new disk actually goes to Windows cache mechanism. And, after the cache is full, all other writes fail. This issue can cause disk formats to fail or can cause Windows delay write fail events.

In all cases, nothing is written to, and you might end up looking for the data that you just copied to the new disk. If there is a need to add storage to the FastBack Server machine, there is a utility called DiskOpen that allows you to define the new storage as read/write.

For now, you can find DiskOpen at:


**Note:** This utility is not part of the installation utilities because it has not been translated into national languages yet. This functionality will change in the next release. The download site is currently only accessible within the IBM intranet. So, if you need that file, contact your IBM representative.

Refer also to FastBack Technical Support pages at:


To use DiskOpen, get the disk number that you want to open for writes using Windows Disk Management. The DiskOpen command syntax is:

```
DiskOpen DISK_NUM <forever>
```

For example, in disk management you add disk number 2. So, to activate disk write temp temporarily, until the disk is removed or FastBack Server is restarted, you can issue **DiskOpen 2**. Otherwise, to open the new disk for writes forever, run the command **DiskOpen 2 forever**.

This behavior is part of the FastBack support for SAN environments, which allows FastBack to connect to SAN volumes for SAN backups, without volume...
ownership problems, because the SAN is connected only after FastBack is installed.

**FastBack Snapshot implications when client is rebooted**

When the client is rebooted to correct an issue, you must consider the following:

- **Performance**

  The best FastBack performance currently documented is around 300-400 Mbps. Field experiences show the full backup is transferring data at around 1 GB per minute. So, backing up a 4 TB volume can take a while (4000 minutes or 67 hours, which is more than 2 days).

- **Delta blocks**

  Every time a server with FastBack Client is rebooted, it runs a delta block snapshot. This snapshot takes approximately the same time as the full snapshot to run. In the case of a 4 TB storage, the server is unprotected for 2 to 3 days on every reboot.

**FastBack backup of database management system**

If an application or DBMS does not have a method to enter a volume-level backup mode, it is recommended to stop the application when the snapshot is initiated so that a good consistency point can be achieved. This downtime is very short because FastBack only needs to establish a consistency point before it restarts the application. Lotus Domino is one such application.

FastBack has built-in consistency check for Microsoft Exchange and Microsoft SQL Server. Any other application or DBMS require the use of pre-consistency point, pre-snapshot, and post-snapshot scripts.

Commands in the pre-consistency point script must put the application or databases in a safe backup mode. For example, DB2 databases can be set to suspended write mode and Oracle in begin backup mode. Sample scripts are provided for this purposes.

When the consistency point is created (which only takes a moment), the pre-snapshot script runs to put the application or databases backup in normal operating mode. After the successful backup, a post-snapshot script runs to perform tasks such as transaction log cleanup.

If an application (such as Lotus Domino) does not have a command to put all of its files on a volume in a safe backup mode, you either have to stop the application in the pre-consistency point script and restart it in the pre-snapshot script, or risk an inconsistent backup. The elapsed time to create the consistency point might be small, so most of the outage will occur while the application is stopping and starting.
The application can be backed without stopping it by starting the backup at idle times and by using VSS backups (on Windows 2003). This is not a recommended method due to potential consistency issues.

For any DBMS that does not allow databases to be placed in backup mode, you can also see if the DBMS supports creating DB backup dumps while the database is accessible, which can then be backed up by FastBack.

**FastBack Continuous Data Protection not recommended for Lotus Domino**

Because Lotus Domino does not have an external method to request a clean up of its transaction logs, it is not safe to run the server in Archive Logging mode when backing it up with a snapshot-based technology such as FastBack.

Because it is not safe to run in Archive Logging mode, but rather in Circular Logging mode, there is no way to make certain that transactions are not missing between snapshot backups. Thus, Continuous Data Protection backups of Domino cannot guarantee data integrity at this time.

If an aggressive Recovery Point Objective with Domino is required, it will be necessary to take more frequent snapshot backups until such time as Domino provides a method to request a transaction log cleanup based upon it being aware of a snapshot backup.

Continuous Data Protection might work on the individual *.NSF files, but there is no guarantee of data integrity because there is no way to script integration between Domino and snapshot-based backups today except to stop the application during each snapshot to get a clean consistency point.

**Too much data during incremental snapshot**

When incremental snapshot backups with the FastBack Client are processing much more data than expected, the cause might be that blocks are changing on the volume that is being backed up.

The FastBack Client will back up any block level change that occurs on the volume since the last snapshot backup was taken, including any changes made by temporary or swap based files, such as:

- Windows temp folders (that is X:\Windows\Temp\)
- Windows virtual paging file (that is X:\pagefile.sys)
- Recycle bin contents (that is X:\Recycle Bin\)
- Hibernation profiles (that is X:\hiberfil.sys)
- System volume cache (that is X:\Sysvol\)
Windows system restoration
Disk defragmentation (that is Windows defragmenter)
Antivirus scans (that is Symantec Antivirus)

It is not possible to define filter structures in the Tivoli Storage Manager backup/archive client, because FastBack is performing full or incremental volume snapshot, not in folder level. To minimize the amount of data that is backed up with each snapshot, identify and isolate any applications or Windows configurations that use space on the volume. Make attempts to relocate file or folder locations that are used by these applications to volumes that are not being snapshot, if possible. Also, do not disable and enable features that will suddenly delete or create large files (such as configuring hibernation profiles).

Maximum number of snapshots
FastBack can support up to value for the number of generations (versions) of snapshot, but we recommend a maximum of 1440 generations. Assuming a high-usage environment where an incremental snapshot job schedule is performed every hour, 1440 generations would result in roughly 60 days (2 months) worth of snapshots that can be restored.

**Note:** Having a high generations value will severely impact the FastBack server repository space requirements, because cleanup will not be performed on any generations of snapshot under the policy until after the sixtieth day.

Cleanup and replication cannot run simultaneously
Cleanup and replication cannot run simultaneously by design, because they depend on the same information from the snapshots. If one process is running, the other process must wait until the first process is complete.

For example, if cleanup is currently being performed, off site replication to the FastBack disaster recovery hub server cannot be performed because the snapshots are being processed by the cleanup process. You must either terminate the cleanup process or wait for it to complete before attempting to run replication. Set your schedules properly.

FastBack and antivirus
Antivirus and anti-spyware programs might interfere with FastBack Server components and procedures as follows:

Antivirus and anti-spyware can damage the Tivoli Storage Manager FastBack Server database and log files, which will cause loss of data.

Online scanning causes high CPU usage during Tivoli Storage Manager FastBack operation, Snapshots might abort or run slow.
You must exclude the following folders from any file-level scanning:

- The FastBack log and configuration files folder and all its subfolders (default C:\Documents and Settings\All Users\Application Data\Tivoli\TSM\FastBack\)
- The Tivoli Storage Manager FastBack program files folder and all its subfolders (default C:\Program Files\Tivoli\TSM\FastBack\)
- FastBack Repository disks/folders (especially crucial when using Continuous Data Protection)


**Tivoli Storage Manager FastBack Mount and Instant Restore not available with Continuous Data Protection**

The FastBack Continuous Data Protection (CDP) feature allows an entire volume to be restored to a single point in time, based on the writes occurring to the volume at the time of the Continuous Data Protection point-in-time placement. Thus, Continuous Data Protection points in time cannot be used with either the FastBack Mount or Instant Restore features, because those options are based on incremental snapshots. Continuous Data Protection snapshots must be restored using the snapshot monitor in FastBack Manager. Only full or incremental snapshots can be used for FastBack Mount or Instant Restore.

**Folder permissions after single file restoration**

A restored file or folder object is inheriting permissions from the parent folder, rather than the original permissions on the file at the time of backup.

Using Windows Explorer to drag-and-drop a file or folder object from an image mounted using FastBack Mount to a target folder will not restore the original security permissions of the object but will force the object to inherit permissions from the folder it was copied into. This result is because of Windows Explorer behavior and is not controlled by FastBack.

To properly restore an object from a mounted image so that the original permissions on the object at the time of the snapshot are restored, use the Windows command line tool XCOPY to restore the data. Refer to Microsoft documentation for information about how to use the XCOPY command.

**6.2.3 Integration considerations**

This section discusses considerations and recommendations for the Tivoli Storage Manager FastBack integration option. For information about the
FastBack and Tivoli Continuous Data Protection for Files interaction

Tivoli Continuous Data Protection for Files is a companion product to FastBack with a different focus:

- **Target environment**
  - FastBack is intended to protect the file and application server landscape
  - Continuous Data Protection for Files is used for user desktop and notebook protection

- **Backup Granularity**
  - FastBack performs volume level snapshots of file and application servers, either periodically or continuously. The criteria is a changed *block*.
  - Continuous Data Protection for Files performs continuous selective (filter-driven) file backups. The criteria is a changed *file*.

- **Restoration capabilities**
  - FastBack can be used for volume, single file and system recovery (Bare Machine Recovery).
  - Continuous Data Protection for Files can restore those files that have been defined as eligible for continuous data protection by filter. Operating system recovery is not possible.

Restoration with Continuous Data Protection for Files can be performed either from local repository, from a remote file server, or directly from Tivoli Storage Manager-Server (if configured).
To combine these Tivoli Continuous Data Protection and FastBack, use the FastBack Client on the file server where Continuous Data Protection for Files client replicates its file data centrally (if no direct Tivoli Storage Manager connection is used). Refer to Figure 6-5 on page 187.

![Figure 6-5 Continuous Data Protection for Files and FastBack interaction](image)

**Backing up FastBack Server with Tivoli Storage Manager client**

The following scenario contains some thoughts about how to back up FastBack Server with Tivoli Storage Manager backup/archive client. However, keep in mind that this scenario has not been officially tested and runs without support.

In this scenario, FastBack Server uses the following file resources on the Windows 2003 machine:

- Installation path: `c:\Program Files\Tivoli\TSM\FastBack`
- The path for customized metadata and log files that are required for FastBack operation: `c:\Document and Settings\All Users\Application Data\Tivoli\TSM\FastBack`
- FastBack repository disks/folders
- Registry entries

FastBack Server can be addressed as an application client to Tivoli Storage Manager without specific Tivoli Storage Manager application support. The most critical component is FastBack Server’s repository disks and the customization files (client, schedule, and policy). To ensure that this data is backed up in a consistent manner, it is necessary to stop the FastBack Server service. Otherwise, the ongoing backup, restoration, or cleanup processes will compromise the backup and lead to performance impacts.

If you decide to automate the repository backup process, then you can include the following commands:

- `net stop "fastback server"`
- `net start "fastback server"`
These commands must be included in the backup schedule as pre- or post-schedule commands. Be sure that you plan this backup for times where no actions are scheduled within FastBack Server (also take the hub server replication and cleanup into consideration).

The internal optimizing processes that FastBack Server uses on the repository disks are not transparent and not controllable from an outside application. Therefore, it is recommended to use full image backups for saving the repository content. See Figure 6-6 for a sample file content of a repository disk.

Incremental backup is not recommended because of the internal optimizing and cleaning processes which might rename and relocate objects frequently, resulting in full backups.
According to the file resources listed previously, the backup process for a FastBack Server entity consists of four different backup operations:

- Use Tivoli Storage Manager Incremental backup to back up the installation path (C:\Program Files...).
- Use Tivoli Storage Manager Archive for the metadata path (C:\Documents and Settings\... ) The *.log and other files are operated in a mode similar to “circular logging” to provide history but to keep the number of files low. So, together with copying content of the last file into the previous file, a new log must be written. Neither an incremental nor a selective backup will reflect this type of operation. Only Archive allows a consistent store and retrieve of all files relating to the Recovery Point Objective that is defined for repository backup/restore.
- Use Tivoli Storage Manager Snapshot Image Backup (VSS) to back up the repository disks.
- Use Tivoli Storage Manager Backup systemstate to back up Windows registry.

**Note:** This process of backing up the FastBack repository can only be used to recover the entire repository.
In addition, FastBack Manager also offers the option of exporting the configuration files into an external disk space or folder which then can be protected by Tivoli Storage Manager incremental backup. See Figure 6-7 for the invoke export option.

![FastBack Manager export option](image)

**VSS snapshots and Windows 64-bit systems**

In the Job Schedule window on FastBack Manager, the option “Use VSS application quiescing” is applied by default and cannot be disabled on 64-bit machines. Errors are listed in the FastBack Client logs (C:\Documents and Settings\All Users\Application Data\tivoli\fastback\client), and VSS errors are listed in the Windows Application event logs similar to:

- Event Type: Error
- Event Source: VSS
- Event Category: None
- Event ID: 12302
Errors included in the client logs are similar those shown in Example 6-1.

Example 6-1  Sample error in client log

MultiFlush (EXTERNAL DLL): Error during the last asynchronous operation
MultiFlush (EXTERNAL DLL): - Returned HRESULT = 0x80042318
MultiFlush (EXTERNAL DLL): - Error text: VSS_E_WRITER_INFRASTRUCTURE
MultiFlush (EXTERNAL DLL): HRESULT Error catched: 0x80042318

Volume Shadow Copy Service error indicates an internal inconsistency was detected in trying to contact shadow copy service writers. This is known to happen on machines that have the System ID (SID) changed. This change can be caused by the NewSID utility from SysInternal or cloning action of the server (VMware copy, Ghost replication).

In order to test for this condition prior to deploying FastBack to a 64-bit image, perform a VSS snapshot at the operating system level before you begin the installation of FastBack. If it fails, you likely are encountering this issue. See a discussion in the Microsoft forum at:


You can create the VSS snapshot from command prompt using the vssadmin create shadow command. You can delete the snapshot afterward using the vssadmin delete shadow command. For more information, see also:


An alternative method to creating a VSS snapshot valid on Windows 2003 only is as follows:

1. Open My Computer and right-click a volume.
2. Select Properties.
3. Click the Shadow Copies tab and click Create Now.

Note: To delete the snapshot, click the newly created snapshot, and click Delete Now.

To resolve the VSS issue, follow these steps:

1. Export the contents of the HKLM\Software\Microsoft\EventSystem key to a registry file (as a backup).
2. Delete the following key:

   HKLM\Software\Microsoft\EventSystem\{26c409cc-ae86-11d1-b616-00805fc79216}\Subscriptions

   Just delete the Subscriptions subkey; leave the EventClasses key.
3. Restart the server.

4. Run the VSSADMIN LIST WRITERS command to cause the VSS entries in the following key to be rebuilt when the VSS writers initialize:

   HKLM\Software\Microsoft\EventSystem\{26c409cc-ae86-11d1-b616-00805fc79216}\Subscriptions

5. Run the VSS snapshot again at the operating system level, and verify in the Windows Event Log that there are no errors.

### 6.3 Tivoli Storage Manager integration

This section describes how to integrate FastBack Hub Server with Tivoli Storage Manager to provide a solution for short-term data recovery requirements and long-term data retention requirements. We discuss the following approach:

- Tivoli Storage Manager FastBack disk-based approach is used to support short-term operational and disaster recovery requirements.
- Tivoli Storage Manager Server (which supports tape) is used for long-term retention requirements. The functions provided allow for either exploiting backup or archive operations.

The following installation protocol and configuration is a modified implementation adapted to our test environment for this book of the procedure that is described in the Tivoli Field Guide white paper *IBM Tivoli Storage Manager FastBack and Backup-Archive Client Integration*, which is available at

http://www-01.ibm.com/support/docview.wss?uid=swg27013540&aid=1
Figure 6-8 shows the configuration for this scenario in our installation.

Figure 6-8  Test lab configuration for FastBack/Tivoli Storage Manager integration

Our configuration includes:

- FastBack Server named NEWHOPE
- FastBack Hub Server also carrying Tivoli Storage Manager backup/archive client
- Tivoli Storage Manager Server named Khartoum

We used the following software:

- FastBack Disaster Recovery Hub Server V5.5.00138
- FastBack Mount v5.5.0138
- FastBackShell V5.5.00138.
- Tivoli Storage Manager Windows backup/archive client V5.5.1.1
- Tivoli Storage Manager Server V5.5.1

**Note:** You can determine the version levels of the different FastBack components either using **Help → About** (in FastBack Manager) or by right-clicking the FastBack executable in the Properties page under the Version tab `c:\Program Files\Tivoli\TSM\FastBack`.  

Chapter 6. Best practices and troubleshooting tips 193
In addition, the FastBack Tape Integration utility is required. You can download the tool from:


FastBack Tape Integration utility is a HTML-based GUI that requires some input and then generating four scripts. The scripts are used for mounting and unmounting snapshots and for running scheduled backup processes by the Tivoli Storage Manager backup/archive client.

If you are already familiar with the FastBackShell command-line syntax, you can create the batch files that are produced by this tool manually. We chose two clients for Tivoli Storage Manager Backup:

- Lima: Exchange server running on drive E:
- VMSRV501: File server running under VMware on drive C:

In our environment, we implemented the Tivoli Storage Manager integration on the FastBack Hub Server, which usually is the most common scenario.

### 6.3.1 Configuration overview

Figure 6-9 shows the overall configuration and data flow in our test environment.
The goal of this setup is to store data in the Tivoli Storage Manager server in a federated name space (file space) so that it appears to the user that the data was originally placed in the Tivoli Storage Manager server directly from the protected file server. This setup allows users to restore data from the Tivoli Storage Manager server to the protected file server without having to understand how the data was migrated from the FastBack server.

This configuration can be realized with the following steps, as illustrated in Figure 6-9 on page 194. First, data is moved from the protected server to the FastBack repository [1] on a scheduled basis. In this example, two policies are created (Exchange_policy and VMSRV501 policy) to take incremental snapshots of the C: drive of VMSRV501 and E: drives of Lima (Exchange server). These snapshots are transferred to FastBack Hub Server by different schedules.

The incremental snapshots of the Microsoft Exchange server Lima are replicated to FastBack Disaster Recovery Hub Server.

Only the most recent snapshots of file server VMSRV501 is replicated once a day to FastBack Hub Server.

**Note:** It is highly recommended to define FastBack policy names in a single string without blanks when intending backup with Tivoli Storage Manager. Blanks or spaces in policy names could cause complicated quote structures in the required Tivoli Storage Manager batch scripts. For example, use VMSRV501_Policy instead of VMSRV501 Policy.

At a different interval (in our example, every 24 hours controlled by Tivoli Storage Manager server schedule), the Tivoli Storage Manager Backup-Archive client performs a file-level incremental backup of the C: drive of VMSRV501 and E: drive of Lima as it is represented in the FastBack repository.

This is accomplished by first creating a FastBack Mount [2] of the data in the FastBack DR Hub “replicated repository content” which exposes an NTFS interface to the backup/archive client (in the figure the volume mount points are exposed as junction points C:\mnt\C and C:\mnt\E). The Tivoli Storage Manager takes a file-level, incremental backup [3] of the data from the FastBack Mount and stores it in the proper file spaces on the Tivoli Storage Manager server (in this example, the file space is called \VMSRV501\C$ which correlates to the C: drive on VMSRV501 and \Lima\E$ which correlates to the E: drive on Exchange server Lima).
6.3.2 Installation steps

The following steps document how to configure the Tivoli Storage Manager Server and Backup-Archive client.

Tivoli Storage Manager Backup-Archive client is installed on the same machine as the Tivoli Storage Manager FastBack Hub Server to move data from the FastBack Hub Server’s replicated repository content into the Tivoli Storage Manager Server repository.

1. Install Tivoli Storage Manager Server and media libraries.

2. Install Tivoli Storage Manager backup/archive client on the FastBack Hub Server.

   **Note:** Be sure to install the latest available Windows Tivoli Storage Manager backup/archive client version V5.5.1 or later.

3. Create Tivoli Storage Manager client nodes. We used the names of the original client (Lima and VMSRV501), in addition register the node for FastBack Hub Server which will be moving the data to the Tivoli Storage Manager server. In our example we used FASTBACK_SRV as node name. The FASTBACK_SRV will act as proxy for the other nodes. Run the commands in Example 6-2.

   **Example 6-2  Tivoli Storage Manager commands**

   ```
   tsm:> register node FASTBACK_SRV <password>
   tsm:> register node LIMA <password>
   tsm:> register node VMSRV501 <password>
   tsm:> grant proxy target=lima agent= fastback_srv
   tsm:> grant proxy target vmserv501 agent=fastback_srv
   ```

4. Launch Tivoli Storage Manager Client configuration wizard on FastBack Hub Server to enter NODENAME FASTBACK_SRV and IP-Address of the Tivoli Storage Manager Server, leave all other entries as default.

5. Extract the FastBack Tape Integration zip file into a directory. We put it into c:\Program Files\Tivoli\TSM\Tapeintegration

6. If the **FastBackShell** is not installed under the default location, edit the TapeIntegration.vbs file and change the sInstallationVolume parameter to the correct value.
7. Run TapeIntegration.html as shown in Figure 6-10. Edit the field Folder with the REP_* path that we defined during FastBack Hub Server installation, see 4.6.2, “Installing FastBack Hub Server” on page 84. Fill in the “User Authentication” fields according to your installation.

Figure 6-10  Tivoli Storage Manager Tape Integration utility
8. Select the **Create Scripts** button to execute the utility. Five scripts will be created in the `\FastBackScripts` directory on the local drive as shown in Figure 6-11 on page 198.

![Figure 6-11 Tivoli Storage Manager Integration utility generated scripts](image)

9. Rework the `Mount.bat` and `Dismount.bat` files to reflect only those entries which are relevant for backup or archive operation.

10. You must copy
    
    C:\Program Files\Tivoli\TSM\FastBack\Shell\FastBackShell.exe to
    
    C:\Program Files\Tivoli\TSM\XpressShell.exe.
    
    Some of the tools available at this time still refer to the old executable naming convention.
11. Run the **Mount.bat** from the command line to verify correct operation. The results are two new directories \FastBackMountedVolumes and \FastBackLogs. The \FastBackMountedVolumes directory now includes the mounted snapshot data of Lima and VMSRV501 as shown in Figure 6-12.

![Mounted volumes](image)

*Figure 6-12  Mounted volumes*

12. Run **dismount.bat** from the command line to verify successful removal of the mounted directories and files (Figure 6-13).

![Command Prompt](image)

*Figure 6-13  Result of dismount.bat operation*
13. Creating script for Tivoli Storage Manager incremental backup (the Tivoli Storage Manager command syntax could also be changed to perform an archive). The -snapshotroot= parameter is the path where the snapshot is mounted after running mount.bat. Call the script TSMbatch.bat, and put it into the Tivoli Storage Manager client program path. See Example 6-3.

Example 6-3  TSMbatch.bat program

```bash
@echo off
set dir="C:\Program Files\Tivoli\TSM\baclient"

cd %dir%
rem Incremental backup of the e: drive of FASTBACKSRV/Hub Server for remote Exchange client Lima
%dir%dsmc.exe incremental e: -asnode=lima
   --snapshotroot="C:\FastBackMountedVolumes\DRrepository\REP_TI8T61\Exchange_Policy\lima\E"

Rem Incremental backup of the c: drive of FASTBACKSRV/Hub Server for remote FS client VMSRV501
%dir%dsmc.exe incremental c: -asnode=vmsrv501
   --snapshotroot="C:\FastBackMountedVolumes\DRrepository\REP_TI8T61\VMSRV501 Policy\VMSRV501\C"
```

14. Running TSMbatch.bat results in backing up the files of Lima and VMSRV501 under the Tivoli Storage Manager nodename FASTBACK_SRV masking as node Lima and VMSRV501. Sample result is shown in Example 6-4.

Example 6-4  Result for TSMBatch command

```
C:\Program Files\Tivoli\TSM\baclient>tsmbatch.bat
IBM Tivoli Storage Manager
Command Line Backup/Archive Client Interface
   Client Version 5, Release 5, Level 1.1
   Client date/time: 09/23/2008 15:48:22
(c) Copyright by IBM Corporation and other(s) 1990, 2008. All Rights Reserved.

Node Name: FASTBACK_SRV
Session established with server KHARTOUM_SERVER1: Windows
   Server Version 5, Release 5, Level 1.0

Accessing as node: VMSRV501
```
Incremental backup of volume 'c:'
ANS1898I ***** Processed 1,000 files *****
Directory--> 0 \vmsrv501\c$ [Sent]
Normal File--> 407,996 \vmsrv501\c$\DIR16\FILE80.DAT [Sent]
Normal File--> 200,902 \vmsrv501\c$\DIR16\FILE81.DAT [Sent]
Normal File--> 270,740 \vmsrv501\c$\DIR16\FILE82.DAT [Sent]

IBM Tivoli Storage Manager
Command Line Backup/Archive Client Interface
Client Version 5, Release 5, Level 1.1
Client date/time: 09/23/2008 15:48:22
(c) Copyright by IBM Corporation and other(s) 1990, 2008. All Rights Reserved.

Node Name: FASTBACK_SRV
Session established with server KHARTOUM_SERVER1: Windows
Server Version 5, Release 5, Level 1.0
Accessing as node: Lima

Incremental backup of volume 'E:'
ANS1898I ***** Processed 1,000 files *****
Directory--> 0 \Lima\E$ [Sent]
Normal File--> 407,996 \Lima\E$\DIR16\FILE80.DAT [Sent]

Elapsed processing time: 00:10:25

15. Set up the Tivoli Storage Manager scheduler. Create a command schedule with pre- and post-processing options. Example 6-5 shows the definitions we used in ITSO environment for VMSRV501, steps must repeated for other nodes.

Example 6-5 Defining schedule

```bash
tsm:> def sched standard vmsrv501 desc="backup vmsrv501 c:"
action=command objects="c:\program files\tivoli\tsm\baclient\tsmbatch.bat" options=""
```
preschedulecmd=c:\fastbackscripts\mount.bat
-postschedulecmd=c:\fastbackscripts\dismount.bat" starttime=23:00:00
tsm:> Define association STANDARD VMSRV501 FASTBACK_SRV

16. Perform a setup for installing the schedule service for the major node FASTBACK_SRV.

6.3.3 Operational aspects with Tivoli Storage Manager client

In general there are two different ways how to perform tape backup of FastBack or FastBack Hub servers client data:

- Backup FastBack Hub Server offline by backing up the repository disks (REP_x, REP_y, REP_z). This might result in a huge amount of data without any granular restoration options. Online backups are not recommended because of interference with actual operations and cleanup. This mode always needs a running FastBack Hub Server for the restoration of files.

- Use the batch mount facility of FastBackShell.exe to mount the individual repository resources for each client and use the proxy node client support of the Tivoli Storage Manager server. This provides a high level of granularity for restore and can restore clients directly.

However, this mode of operation generates load on the Tivoli Storage Manager database because file-level backups are performed and it might also be useful to provide Tivoli Storage Manager diskpool as a cache due to slow incoming data, before migrating it to high performance tape.

In a branch office environment with several individually managed FastBack servers replicating to a central disaster recovery location. There might be an unpredictable number of changes in schedules and disaster recovery policies done by local administrators, which also results in required work for the Tivoli Storage Manager Backup administrator having the need of defining new proxy nodes and adjusting the backup scripts (possibly on a daily basis).
Appendixes
Volume Shadow Copy Service

This appendix contains information about Volume Shadow Copy Service and its interaction with Tivoli Storage Manager FastBack. It includes the following topics:

- “Volume Shadow Copy Service (VSS) overview” on page 206
- “Configuring Volume Shadow Copy Services” on page 207
Volume Shadow Copy Service (VSS) overview

Microsoft Windows Server 2003 includes the Volume Shadow Copy Service (VSS). VSS is a mechanism for creating consistent point-in-time copies of data, which is also known as shadow copies. With VSS, you can create consistent snapshots of selected volumes. Tivoli Storage Manager FastBack fully supports the use of VSS in Windows Server 2003.

Tivoli Storage Manager FastBack implements a VSS software provider, which allows the creation of snapshots and ensures the consistency and integrity of the snapshots.

Figure A-1 shows how the VSS interfaces with various components to create a shadow copy of a volume.

Figure A-1  VSS service architecture
Configuring Volume Shadow Copy Services

The VSS provides writer applications, such as SQL and Exchange, with a notification that a backup is about to be initiated. This notification allows the application to finalize pending operations, which ensures a consistent and integral backup. Using the Tivoli Storage Manager FastBack Manager VSS Flush feature, the VSS signals the writer applications to stop for a moment and allow backup to start.

Note: VSS supports only Windows 2003 server and later. If you use VSS to take snapshots on a Windows 2000 system, the job aborts and a message displays, which indicates that VSS is not supported on Windows 2000.

To activate the VSS feature, complete the following steps in the FastBack Manager window:

1. Click General Configurations.
2. In the right pane, click Applications.
3. Select VSS.
4. Click Apply.

VSS can also be selected using the Job Schedule:

1. Select a Job Schedule.
2. In the Job Schedule window click Application Aware.
3. Select Preserve application consistency → Use VSS application quiescing.
4. Click OK → Apply.

Using the Quiescing parameter while using VSS still provides consistent backup in the case of Exchange but is not recommended for SQL. If the Quiescing parameter is not selected, the consistency is based on VSS capabilities and the designated Writer application.

Note: To use VSS, you need to verify that your application is VSS aware.

In addition, you need to install the following updates for VSS support:

- [http://support.microsoft.com/kb/833167](http://support.microsoft.com/kb/833167)
- [http://support.microsoft.com/kb/831112](http://support.microsoft.com/kb/831112)
- [http://support.microsoft.com/kb/887827](http://support.microsoft.com/kb/887827)
REXX utility for simulating file server operation

This appendix describes a utility, pop.rex, that we used during our Tivoli Storage Manager FastBack testing to simulate ongoing updates to data and increases in data in a user shared file server environment. We wrote this utility using Restructured Extended Executor (REXX™).

Note: We offer this utility as is and without responsibility for its correct operation or any data corruption that occurs if the utility is applied incorrectly. You might need to change the utility to work in your environment.

To use this utility, you need an Open Object REXX runtime environment, which you can download as open source from the following Web address:

http://sourceforge.net/project/showfiles.php?group_id=119701

Although Open Object REXX is supported on many operating systems, we wrote the utility for a Windows environment and tested it only in that environment. Running the utility in an operating system other than Windows might require changes in the REXX function calls.
**REXX utility operation**

To use the pop.rex utility, you need to copy it to the path where you want the file server operation simulation to take place. Assuming that you have the REXX interpreter within your path, you can run the utility as follows:

1. Start pop.rex with the attribute `generate` in a command-line window.

   The utility generates a predefined number of directories and files. You can modify the number of directories that are created in the declaration part of the utility by using an editor and changing the value of the variable `f.!NUMDIR`.

   The utility then creates a number of files in each directory with a size between several 10 KB up to some number of MB. See Figure B-1 for the initial file structure that is generated.

2. After the directories are generated, then run pop.rex with the attribute `simulate` in the same command-line window.

   This procedure now runs forever until you cancel it by using Ctrl+c or until you close the command-line window. The utility generates new files, appends lines to existing objects, or deletes and generates files new in a random manner. You can define the time interval in seconds between these operations by changing the value of variable `f.!TMAX`.

---

**Figure B-1  File structure after running pop.rex generate**

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>Type</th>
<th>Date Modified</th>
</tr>
</thead>
<tbody>
<tr>
<td>FILE00.DAT</td>
<td>31 KB</td>
<td>DAT File</td>
<td>9/10/2008 4:16 AM</td>
</tr>
<tr>
<td>FILE01.DAT</td>
<td>854 KB</td>
<td>DAT File</td>
<td>9/15/2008 4:56 PM</td>
</tr>
<tr>
<td>FILE02.DAT</td>
<td>310 KB</td>
<td>DAT File</td>
<td>9/15/2008 4:56 PM</td>
</tr>
<tr>
<td>FILE03.DAT</td>
<td>931 KB</td>
<td>DAT File</td>
<td>9/14/2008 8:50 PM</td>
</tr>
<tr>
<td>FILE04.DAT</td>
<td>156 KB</td>
<td>DAT File</td>
<td>9/15/2008 4:56 PM</td>
</tr>
<tr>
<td>FILE05.DAT</td>
<td>1,132 KB</td>
<td>DAT File</td>
<td>9/12/2000 4:00 AM</td>
</tr>
<tr>
<td>FILE06.DAT</td>
<td>350 KB</td>
<td>DAT File</td>
<td>9/15/2008 4:56 PM</td>
</tr>
<tr>
<td>FILE07.DAT</td>
<td>649 KB</td>
<td>DAT File</td>
<td>9/15/2008 3:23 PM</td>
</tr>
<tr>
<td>FILE08.DAT</td>
<td>569 KB</td>
<td>DAT File</td>
<td>9/11/2008 1:02 PM</td>
</tr>
<tr>
<td>FILE09.DAT</td>
<td>766 KB</td>
<td>DAT File</td>
<td>9/13/2008 7:03 AM</td>
</tr>
<tr>
<td>FILE10.DAT</td>
<td>548 KB</td>
<td>DAT File</td>
<td>9/15/2008 4:56 PM</td>
</tr>
<tr>
<td>FILE12.DAT</td>
<td>1,415 KB</td>
<td>DAT File</td>
<td>9/14/2008 11:54 PM</td>
</tr>
<tr>
<td>FILE13.DAT</td>
<td>744 KB</td>
<td>DAT File</td>
<td>9/14/2008 8:54 PM</td>
</tr>
<tr>
<td>FILE14.DAT</td>
<td>276 KB</td>
<td>DAT File</td>
<td>9/13/2008 3:33 AM</td>
</tr>
<tr>
<td>FILE15.DAT</td>
<td>340 KB</td>
<td>DAT File</td>
<td>9/15/2008 12:03 PM</td>
</tr>
</tbody>
</table>
In our testing, we used different values on our file servers (from 20 up to 90). See figure B-2 for typical operation.

```
C:\FastBack\Fileserver\User_share\Andy\DIR4\FILE44.DAT
The process cannot access the file because it is being used by another process.
Sleeping 90 secs
Making up
Working with DIR0 FILE07.DAT
Appending 5037
Sleeping 90 secs
Making up
Working with DIR14 FILE01.DAT
Creating new
Sleeping 90 secs
Making up
Working with DIR8 FILE16.DAT
Delete and re-create
C:\FastBack\Fileserver\User_share\Andy\DIR8\FILE16.DAT
```

*Figure B-2  REXX update operation*

**Note:** Because the utility is running forever and creates an increasing amount of data over time, it is highly recommended that you monitor the filling level of the file system resources carefully. In the initial *generate* run, we saw about 80 MB of data in 20 directories, which grew over some days to GB. The update frequency can control the data growth, so you need to set the `f.TMAX` variable carefully.

### REXX utility source code

Example B-1 includes the pop.rex utility source code. You can find information about downloading the utility in Appendix C, “Additional material” on page 215.

```
/* POP.rex */
parse arg type .
select
  when type='' then do
    say "Syntax: POP <type>"
    say " type can be generate or simulate "
  end
  when type='generate' then do
    call generate
  end
  when type='simulate' then do
    call simulate
  end
otherwise nop
```
exit

setupvar: procedure expose f.
    f. = ''
    call RxFuncAdd 'SysLoadFuncs', 'rexxutil', 'SysLoadFuncs'
    call SysLoadFuncs
    f.!'TEXT = "The quick brown fox jumps over a lazy dog"
    f.!'LEN = 43
    f.!'ANUM = "ABCDEFGHIJKLMNOPQRSTUVWXYZ1234567890"
    f.!'DPRE = "DIR"
    f.!'FPRE = "FILE"
    f.!'FLEN = 2
    f.!'FNUM = 50 /* Numbers of files in Directory */
    f.!'LMIN = 100 /* # of records minimum randomized */
    f.!'LMAX = 10000 /* # of records Maximum randomized */
    f.!'TMAX = 20 /* Wait-time during simulate */
    f.!'NUMDIR = 20 /* Numbers of directories being generated */
    return

generate: procedure expose f.
    call setupvar
    /* check directories */
    call SysFileTree f.!'DPRE||"*",dn.,"DO"
    if (dn.0 >= 1) then do
        say "directories already exists"
        say "cannot generate over an existing path"
        return
    end
    /* create directories */
    do i = 0 to f.!'NUMDIR
        "MD" f.!'DPRE||i
    end
    /* create random files */
    do i = 0 to f.!'NUMDIR
        dirname = f.!'DPRE||i
        do j = 0 to f.!'FNUM
            fname = f.!'FPRE
            do k = 1 to f.!'FLEN
                fname = fname || random(9)
            end
            fname = fname||".DAT"
            call SysFileTree dirname||'\'||fname,fn.
            if fn.0=0 then do
                call fill dirname fname
simulate: procedure expose f.
call setupvar
  /* check directories */
call SysFileTree f.!DPRE||"*",dn.,"DO"
if (dn.0 <> f.!NUMDIR) then do
  say "directories does not exists"
  say "run generate first"
  return
end
  /* modify / create / delete files */
do forever
  dirname = f.!DPRE||random(9)
  fname = f.!FPRE
  do k = 1 to f.!FLEN
    fname = fname || random(9)
  end
  fname = fname||'.DAT'
call SysFileTree dirname||'\'||fname,fn.
say "Working with" dirname fname
  if fn.0=0 then do
    say "Creating new"
call fill dirname fname
  end
  else do
    recnum = random(f.!LMIN, f.!LMAX)
a=linein(dirname||'\'||fname)
    if recnum>a then do
      /* append */
call lineout dirname||'\'||fname, recnum, 1
      if recnum=
         then recnum=10000
      if a = "" then a=999
      if recnum<=a then numrec=1234
      else numrec = recnum - a
      do k = 1 to numrec
        call lineout dirname||'\'||fname, f.!TEXT, a+k
      end
      say "Appending" numrec
    end
  end
end
return
say "Delete and re-create"
'DEL' dirName||'\'||fname
    call fill dirName fname
end
end
say "Sleeping" f.!TMAX "secs"
call SysSleep f.!TMAX
say "Waking up"
end
return

fill: procedure expose f.
arg dirName fname
    recnum = random(f.!LMIN, f.!LMAX)
call lineout dirName||'\'||fname, recnum
do k = 1 to recnum
    call lineout dirName||'\'||fname, f.!TEXT
end
call lineout dirName||'\'||fname
return
Additional material

This book refers to additional material that you can download from the Internet as described in this appendix.
Locating the Web material

The Web material that is associated with this book is available in softcopy on the Internet from the IBM Redbooks publications Web server. Point your Web browser at:

ftp://www.redbooks.ibm.com/redbooks/SG247685

Alternatively, you can go to the IBM Redbooks publications Web site at:

ibm.com/redbooks

Select Additional materials and open the directory that corresponds with the IBM Redbooks publications form number, SG247685.

Using the Web material

The additional Web material that accompanies this book includes the following files:

- **SG247685.zip**: Main zipped file with pop.rex
- **pop.rex**: Sample REXX code for simulating file system activity

System requirements for downloading the Web material

The following system configuration is recommended:

- **Hard disk space**: 100 MB for data
- **Operating System**: Windows 2000 or Windows 2003
- **Software**: Object REXX interpreter

How to use the Web material

Create a subdirectory (folder) on your workstation, and decompress the contents of the Web material zipped file into this folder.
# Abbreviations and acronyms

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACPI</td>
<td>Advanced Configuration and Power Interface</td>
</tr>
<tr>
<td>AIK</td>
<td>Automated Installation Kit</td>
</tr>
<tr>
<td>AIX</td>
<td>Advanced Interactive Executive</td>
</tr>
<tr>
<td>API</td>
<td>Application Programming Interface</td>
</tr>
<tr>
<td>ATI</td>
<td>Array Technologies Incorporated</td>
</tr>
<tr>
<td>BIOS</td>
<td>Basic Input Output System</td>
</tr>
<tr>
<td>BMR</td>
<td>Bare Machine Recovery</td>
</tr>
<tr>
<td>BPIC</td>
<td>Business Partner Innovation Center</td>
</tr>
<tr>
<td>CCS</td>
<td>Central Control Station</td>
</tr>
<tr>
<td>CD-ROM</td>
<td>Compact Disk Read Only Memory</td>
</tr>
<tr>
<td>CDP</td>
<td>Continuous Data Protection</td>
</tr>
<tr>
<td>CLI</td>
<td>Command Line Interface</td>
</tr>
<tr>
<td>CPU</td>
<td>Central Processing Unit</td>
</tr>
<tr>
<td>DAS</td>
<td>DB2 Administration Server</td>
</tr>
<tr>
<td>DB2</td>
<td>Database 2™</td>
</tr>
<tr>
<td>DBMS</td>
<td>Database Management System</td>
</tr>
<tr>
<td>DHCP</td>
<td>Dynamic Host Configuration Protocol</td>
</tr>
<tr>
<td>DLL</td>
<td>Dynamic Link Library</td>
</tr>
<tr>
<td>DNS</td>
<td>Domain Name Services</td>
</tr>
<tr>
<td>DVD</td>
<td>Digital Video Disc</td>
</tr>
<tr>
<td>EDB</td>
<td>Exchange Database</td>
</tr>
<tr>
<td>FTP</td>
<td>File Transfer Protocol</td>
</tr>
<tr>
<td>FXP</td>
<td>File Exchange Protocol</td>
</tr>
<tr>
<td>GPT</td>
<td>GUID Partition Table</td>
</tr>
<tr>
<td>GUI</td>
<td>Graphical User Interface</td>
</tr>
<tr>
<td>GUID</td>
<td>Globally Unique Identifier</td>
</tr>
<tr>
<td>HAL</td>
<td>Hardware Abstraction Layer</td>
</tr>
<tr>
<td>HTML</td>
<td>Hypertext Markup Language</td>
</tr>
<tr>
<td>IA64S</td>
<td>Intel Architecture 64-bit</td>
</tr>
<tr>
<td>IBM</td>
<td>International Business Machines Corp.</td>
</tr>
<tr>
<td>IDE</td>
<td>Integrated Drive Electronics</td>
</tr>
<tr>
<td>IIS</td>
<td>Internet Information Services</td>
</tr>
<tr>
<td>IMR</td>
<td>Individual Mailbox Recovery</td>
</tr>
<tr>
<td>ISO</td>
<td>International Standard Organization</td>
</tr>
<tr>
<td>ITIL</td>
<td>Information Technology Infrastructure Library</td>
</tr>
<tr>
<td>ITSO</td>
<td>International Technical Support Organization</td>
</tr>
<tr>
<td>LAN</td>
<td>Local Area Network</td>
</tr>
<tr>
<td>LUN</td>
<td>Logical Unit Number</td>
</tr>
<tr>
<td>MBR</td>
<td>Master Boot Record</td>
</tr>
<tr>
<td>NAS</td>
<td>Network Attached Storage</td>
</tr>
<tr>
<td>NIC</td>
<td>network interface card</td>
</tr>
<tr>
<td>NSF</td>
<td>Notes file</td>
</tr>
<tr>
<td>NTFS</td>
<td>NT file system</td>
</tr>
<tr>
<td>RAID</td>
<td>Redundant Array of Independent Drives</td>
</tr>
<tr>
<td>RAM</td>
<td>Random Access Memory</td>
</tr>
<tr>
<td>RDAC</td>
<td>Redundant Disk Array Controller</td>
</tr>
<tr>
<td>REXX</td>
<td>Restructured Extended Executor</td>
</tr>
<tr>
<td>RPO</td>
<td>Recovery Point Objectives</td>
</tr>
<tr>
<td>RTO</td>
<td>Recovery Time Objectives</td>
</tr>
<tr>
<td>SAN</td>
<td>Storage Area Network</td>
</tr>
<tr>
<td>SATA</td>
<td>Serial Advanced Technology Attachment</td>
</tr>
<tr>
<td>Acronym</td>
<td>Full Form</td>
</tr>
<tr>
<td>---------</td>
<td>-----------</td>
</tr>
<tr>
<td>SCSI</td>
<td>Small Computer System Interface</td>
</tr>
<tr>
<td>SDD</td>
<td>Subsystem Device Driver</td>
</tr>
<tr>
<td>SID</td>
<td>System ID</td>
</tr>
<tr>
<td>SMTP</td>
<td>Simple Mail Transport Protocol</td>
</tr>
<tr>
<td>SQL</td>
<td>Structured Query Language</td>
</tr>
<tr>
<td>SSL</td>
<td>Secured Socket Layer</td>
</tr>
<tr>
<td>SVC</td>
<td>SAN Volume Controller</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>Transmission Control Protocol/Internet Protocol</td>
</tr>
<tr>
<td>TLS</td>
<td>Tape Library System</td>
</tr>
<tr>
<td>VSS</td>
<td>Volume Shadow-Copy Services</td>
</tr>
<tr>
<td>WAN</td>
<td>Wide Area Network</td>
</tr>
</tbody>
</table>
Related publications

We consider the publications that we list in this section particularly suitable for a more detailed discussion of the topics that we cover in this book.

IBM Redbooks publications

For information about ordering these publications, see “How to get IBM Redbooks publications” on page 221. Certain documents referenced here might be available in softcopy only.

- IBM Tivoli Storage Manager Versions 5.4 and 5.5 Technical Guide, SG24-7447
- IBM Tivoli Storage Manager Implementation Guide, SG24-5416
- IBM Tivoli Storage Management Concepts, SG24-4877

Other publications

The following publications are also relevant as further information sources:

- IBM Tivoli Storage Manager Messages, SC32-0140
- IBM Tivoli Storage Manager Performance Tuning Guide, SC32-0141
- IBM Tivoli Storage Manager Problem Determination Guide, SC32-0142
- IBM Tivoli Storage Manager for Windows Installation Guide, GC23-5973
- IBM Tivoli Storage Manager for Windows Administrator’s Guide, SC32-0121
- IBM Tivoli Storage Manager for Windows Administrator’s Reference, SC32-0127
Online resources

These Web sites are also relevant as further information sources:

- Tivoli Storage Manager FastBack Information Center

- Tape integration download

- Tivoli Storage Manager FastBack quick start guides

- Tivoli Storage Manager FastBack support pages

- Tivoli Field Guide white papers related to Tivoli Storage Manager:

- Support page for adding repository

- Windows Automated Installation Kit download

- Tivoli Storage Manager BA client integration guide
  http://www-01.ibm.com/support/docview.wss?uid=swg27013540&aid=1

- TestDisk
  http://www.cgsecurity.org/wiki/TestDisk_Download

- Lister
  http://www.ghisler.com/lister/
How to get IBM Redbooks publications

You can search for, view, or download IBM Redbooks, Redpapers, Technotes, draft publications and Additional materials, as well as order hardcopy Redbooks, at this Web site:

ibm.com/redbooks

Help from IBM

IBM Support and downloads

ibm.com/support

IBM Global Services

ibm.com/services
Index

Numerics
64-bit 190

A
Active Directory, see AD
AD 178
Administrative Command Line Client 11
anti-spam 184
AntiVirus 184
architecture 6

B
Bare Machine Recovery, see BMR
BMR 17, 21
preparation 94
recovery scenario 162
requirements 27
VMware 178
BMR CD 94
BuildTSMFastBackBMRCDBat command 102
BusLogic 106

C
capture snapshot 125
CD 94
CDP 8, 136
   configuration 137
Lotus Domino 183
   restore 138
   snapshot 138
CDP for Files 186
Central Control Station 11, 84
   configuration 92
chkdsk command 10
client 8
client backup 116
client group
   definition 117
Client groups 116
client requirements 25
clock 177
commands

D
data collection 42
Database Management System, see DBMS
DBMS 182
   backup 182
demonstration 110
deployment environment 35
device drivers 106
Disaster Recovery 90
DiskOpen command 181
DR Hub Server 11
DR Server 11
drivers 106

E
e1000 178
EDB file 144
environment setting 111
event log 173
Exchange
   object restore 144

BuildTSMFastBackBMRCDBat.bat 102
chkdsk 10
DiskOpen 181
FastBackShell 196
FastBackShell.exe 202
Mount.bat 198
NewSID 191
pop.rex 210
Regedit 180
TSMbatch.bat 200
vssadmin 191
XCOPY 185
component installation 61
configuration
   CDP 137
   client backup 116
disaster recovery 90
considerations 27
Continuous Data Protection, see CDP
copy-on-write (COW) 8
M
MAPI client 144
master boot record, see MBR
MBR 28
Microsoft Exchange 27, 141
Microsoft Outlook 65
Microsoft SQL Server 26, 153
    backup 153
    configuration 153
    restore 159
Mount.bat command 198
multipath I/O 24–25

N
network driver 178
network interface card, see NIC
network shares 180
new storage 181
NewSID command 191
NIC 94
Non-quiescent 141

O
object restore 144
operational considerations 30

P
personal folder 144
point-in-time copy 8
Policies 116
policy
    definition 121
    testing 125
pop.rex command 210
positioning 5
product architecture 6
project kick-off 41
project planning 39
PST file 144

Q
Quiescent 141

R
readiness checklist 33
read-only disk 181
recovery 126
Recovery Point Objectives, see RPO
Recovery Time Objectives, see RTO
Redbooks Web site 221
    Contact us xi
Regedit command 180
repository 27, 112
    definition 114
    initial configuration 112
required skills 40
requirement collection 42
requirements 24
    BMR 27
    client 25
    Microsoft Exchange 27
    Microsoft SQL Server 26
    server 24
REXX 111
RPO 42
RTO 42

S
SAN disk 181
scenarios 110
schedule
    definition 119
Schedules 116
security 178
SID 191
Simple Mail Transport Protocol, see SMTP
simulation 111
sizing 30
SMTP 151
snapshot 18, 125
    boot 182
    data size 183
    generation 184
software requirements 25
    client 26
solution environment 23
solution introduction 3
System ID, see SID

T
task breakdown 41
TestDisk 101
tiered recovery snapshot 18
Tivoli Storage Manager
integration 192
Tivoli Storage Manager client 32, 187
operational aspects 202
troubleshooting 172
TSMbatch.bat command 200

V
value proposition 17
vlance 178
VMware 106
flexible 178
vlance 178
VMware driver 106
vmxnet 106
volume recovery 127
Volume Shadow-copy Services, see VSS
VSS 35
vssadmin command 191

W
Windows 2003 FTP-Server 79
Windows 64-bit 190
Windows Automated Installation Kit 95

X
XCOPY command 185
Deployment Guide Series:
IBM Tivoli Storage Manager FastBack

Provides an overview of this Windows-based backup and recovery solution

Discusses extensively how to implement and use the solution

Includes service solution scenarios as well as best practices

This IBM Redbooks publication is written as part of the deployment guide series. It discusses the IBM Tivoli Storage Manager FastBack product family. Tivoli Storage Manager FastBack is a complete backup, recovery, and continuous data protection solution for Windows based servers. It is a new addition to the IBM Tivoli Storage Manager family of products.

Tivoli Storage Manager FastBack includes a specialized solution for backing up Microsoft Exchange server and provides Bare Machine Recovery. Tivoli Storage Manager FastBack also supports a disaster recovery scenario by providing a hub server that centralizes recovery from multiple locations.

The book is written in a deployment guide format. Thus, it contains an extensive guide for implementation services and requirement considerations. It explains how to install Tivoli Storage Manager FastBack, as well as how to use the solution. It also includes demonstration scenarios.

For more information: ibm.com/redbooks